End-User Guide

For ImageNow 5.4x

Copyright and trademark attributions

ImageNow and CaptureNow are registered trademarks of Perceptive Software, Inc. Other products produced by Perceptive Software, Inc., are Perceptive Software trademarks. All other brands and product names mentioned in this document are trademarks or registered trademarks of their respective owners.

Copyright© 2006 Perceptive Software, Inc. All rights reserved.

Document Date: 02/16/06
Table Of Contents

Getting Started ................................................................. 1
About working in the ImageNow Client ......................... 1
Log in and start the ImageNow Client ......................... 2
Verify the applet you are using ..................................... 3
The ImageNow Client control bar ................................... 4
Check your ImageNow version ....................................... 5
Scanners supported by ImageNow ................................. 5
Disconnect from ImageNow Server ................................. 5
Exit ImageNow ............................................................... 6
Getting Help .................................................................................. 6
About the ImageNow Help system .................................. 6
Get ImageNow Help on the Web ....................................... 7
Contact technical support .................................................. 7
Shortcuts .................................................................................. 10
Enable the ImageNow tray icon ..................................... 10
ImageNow shortcut keys ...................................................... 10
ImageNow Toolbars ............................................................... 13
File toolbar ............................................................................ 13
Scan toolbar .......................................................................... 14
Package Scan toolbar ......................................................... 14
Search grid toolbar ............................................................. 15
View toolbar ........................................................................... 16
Page viewing toolbar .......................................................... 16
Preview toolbar ................................................................. 17
Workflow toolbar ............................................................... 17
Annotation toolbar ............................................................. 18
Batch QA toolbar ............................................................... 19
Batch Link toolbar ............................................................. 19
Customize toolbars ............................................................ 20
Reset toolbars ................................................................. 21
Move or resize toolbars ..................................................... 21

Viewing Documents ........................................................... 23
About viewing a document ............................................. 23
About PowerView windows .............................................. 24
Add or view notes on a document .................................. 27
View a document ............................................................... 28
View a document in its original application .................. 28
Open all pages of a document at once ......................... 28
Invert a document image .................................................. 28
Table Of Contents

Linking documents ......................................................................................................................... 43
  What is linking? ............................................................................................................................. 43
  Link a document or batch ............................................................................................................ 43
  Put a page on hold during linking .............................................................................................. 45
  Discard a page during linking ..................................................................................................... 45
  Turn on the Relink icon ................................................................................................................ 46
  Reorganize a captured document .................................................................................................. 46
  Using Group and Link, and Link Commit ..................................................................................... 46
  Suspend or stop linking a batch ................................................................................................... 47

E-mail ........................................................................................................................................... 49
  About e-mailing documents ......................................................................................................... 49
  E-mail a document ........................................................................................................................ 49
  Set up e-mail options .................................................................................................................... 50
  Export a document ........................................................................................................................ 51

Search .......................................................................................................................................... 53
  About searching for a document ................................................................................................. 53
  Search by an index key (Simple) .................................................................................................. 53
  Search using multiple index keys (Advanced) ............................................................................ 54
  Add a search condition in Advanced search (SQL) ..................................................................... 54
  Create and run a search query ..................................................................................................... 56
  Modify or remove a query ............................................................................................................. 57
  Explore documents by index key .................................................................................................. 57
  ImageNow search conditions and operators ............................................................................... 57
  Sort search results ....................................................................................................................... 62
  Lock grid data .............................................................................................................................. 62
  Customize search .......................................................................................................................... 62
    Set the number of documents to retrieve .................................................................................... 62
    Change the Search grid display .................................................................................................. 63
    Return to your last position in search ......................................................................................... 64
    Modify search column headers ................................................................................................. 64
    Select a new column header ....................................................................................................... 64
    Create column headers from an applet ....................................................................................... 64
    Customize a column header on the Search grid ....................................................................... 64
  ImageNow ERM and Content Server .......................................................................................... 65
    Add a search condition in ERM search ....................................................................................... 65
    Add a search condition in Content search .................................................................................. 66
    Search ImageNow ERM .............................................................................................................. 70
    Search the text of documents (Content) ................................................................................... 70

Workflow .......................................................................................................................................... 73
  About workflow ............................................................................................................................ 73
  Workflow grid view ...................................................................................................................... 74
  Troubleshoot workflow ................................................................................................................. 75
Set up workflow ................................................................................................................................. 76
Select a start queue .................................................................................................................................. 76
Select a work queue ................................................................................................................................. 77
Workflow status bar and alarms .............................................................................................................. 77
Using workflow ........................................................................................................................................ 77
Send a document to workflow ................................................................................................................ 77
Set up and view recently routed items ..................................................................................................... 77
View documents in a workflow queue ...................................................................................................... 78
Route items in a queue ............................................................................................................................... 79
Process an item in workflow .................................................................................................................... 81
Put a workflow item on hold .................................................................................................................... 81
Retrieve a workflow item on hold ........................................................................................................... 82
Relink a document in workflow ............................................................................................................... 82
Hold, delete or cancel workflow processing ............................................................................................ 83
Remove a document from workflow ........................................................................................................ 83
Search for a document in workflow ........................................................................................................ 84
Sort fields in a workflow grid ................................................................................................................... 84
Preview and merge pages in workflow .................................................................................................... 84
EOB Processing ........................................................................................................................................ 85
About EOB processing ............................................................................................................................. 85
Use EOB to link documents in workflow ............................................................................................... 87

**Annotations** ........................................................................................................................................ 91
What is an annotation? ............................................................................................................................... 91
Add a check annotation .............................................................................................................................. 91
Add a highlight annotation .......................................................................................................................... 92
Add a hollow mask annotation .................................................................................................................. 92
Add a redline annotation ............................................................................................................................. 93
Add a solid mask annotation ..................................................................................................................... 94
Add a sticky note annotation ...................................................................................................................... 94
Edit a sticky note ....................................................................................................................................... 95
Add a text annotation ............................................................................................................................... 95
Show or hide annotations ............................................................................................................................ 96
Delete an annotation ................................................................................................................................ 96
Turn off annotations .................................................................................................................................. 97
Add an arrow annotation ............................................................................................................................ 97
Attach a document to an ImageNow document ......................................................................................... 97

**Stamps** ..................................................................................................................................................... 98
Create a text or graphic stamp .................................................................................................................... 98
Code variables for a custom stamp ............................................................................................................. 99
Add a stamp annotation .............................................................................................................................. 100
Remove a stamp ....................................................................................................................................... 101
Turn a stamp on or off ............................................................................................................................... 101
Run the Rubber Stamp Wizard .................................................................................................................. 101
<table>
<thead>
<tr>
<th>Index</th>
<th>103</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize annotations</td>
<td>101</td>
</tr>
<tr>
<td>Set annotation preferences</td>
<td>101</td>
</tr>
<tr>
<td>Modify a stamp</td>
<td>102</td>
</tr>
<tr>
<td>Move or resize an annotation</td>
<td>102</td>
</tr>
</tbody>
</table>
Getting Started

About working in the ImageNow Client

ImageNow gives you single-click access to documents while you work. The ImageNow Client is easy to use and unobtrusive in your workspace, and the benefits are immediate. If you need to solve a broad set of document-efficiency problems or simply eliminate copious amounts of paper, ImageNow can do the job. It adapts to your business processes and ensures that all documents are securely online, quickly retrievable, and tied to the files and applications you want, with any comments and your stamp of approval included. ImageNow can also capture, translate, retrieve and export data from e-mails, reports, and non-image file formats such as DOC and TXT.

1. The **ImageNow Client** title bar — right-click and choose from numerous administrative configuration and management options.

2. The **Applet** list contains the applet names that each contain all the information ImageNow requires to communicate with one or more host applications.

3. The **View**, **Scan**, **Batch**, **Search**, and **Workflow** buttons let you: View documents linked to your host application; scan more documents into ImageNow from a scanner or a file system; batch process documents by conducting quality assurance and linking; conduct searches on documents in ImageNow in order to, for example, view document status and properties; and process documents in workflow which reflect the process requirements of your environment.

4. **ImageNow Status Field** provides status on documents as they are routed and reviewed in workflow.

**Processing documents in ImageNow**

Processing documents involves three essential tasks for getting your document images and any unstructured data into ImageNow and integrating them with your host application. The first step is to capture the documents into ImageNow, which is typically done by scanning or importing them from a computer. Next you review each document to ensure they were captured to the standards of quality that you need. Once you have quality assured your documents, you link them to index keys so that they are grouped in a logical order and matched to records in your host application. After these required steps are completed, you can use numerous features in ImageNow such as annotations, e-mail and export, and workflow.
ImageNow can run on different operating systems including Microsoft Windows and UNIX platforms, and it can support thousands of users, numerous external database options, and more than two hundred file types. Additionally, ImageNow can fit into just about any vertical market and quickly streamline business processes. For additional information, search this Help file or ask your Perceptive Software contact about our white papers, technical specifications, and brochures.

Log in and start the ImageNow Client

ImageNow can be started in several ways. You can start ImageNow by double-clicking the ImageNow icon on the desktop, or by clicking Start, pointing to Programs, and then clicking ImageNow; you can also start ImageNow by clicking the Tray icon.

Important  If the Profile list is blank, then a Login Profile has not been configured. Please contact your system administrator to configure the following profile entries: Server ID, Protocol, Port Number, and User ID.
In the Profile list, select the profile you want to use.

1. In the User ID box, confirm or enter the user name.
2. In the Password box, enter your password.
3. Click Connect to initiate the connection to the ImageNow Server. The ImageNow Client control bar displays if you are successfully logged into ImageNow:

   **Note** If you are unable to connect to the server, verify that you entered the user ID and password correctly.

### Verify the applet you are using

The Applet list on the ImageNow Client control bar shows the currently selected applet. An applet holds the information that ImageNow needs to communicate with and gather data from your host application. In most cases, a single applet is used to communicate with the host application. If ImageNow has been integrated with more than one host application, you may have multiple applets to choose from in the list.

1. Click the down arrow on the Applet list, and then select the applet you want to use.
2. The newly selected applet displays by default in the Applet list.
The ImageNow Client control bar

![ImageNow Client Control Bar Diagram]

1. **Title Bar**
   - The **ImageNow Client** title bar — right-click and choose from numerous administrative configuration and management options. In addition, when the ImageNow Client is connected to the server (that is, logged in), the name of the connect profile and the user ID will display. If the client is not connected to the server, no information will display after the version number.

2. **Applet**
   - The **Applet** list contains applets that integrate information between ImageNow and your host application. So, for example, if you work in the Financial Aid department at a university, you might have an applet called FINAID. With your FINAID applet selected in the ImageNow Client control bar and your host application open to a student record, you have single-click access to ImageNow documents linked to that student.

3. **Control Bar Button Options**
   - The following options are available, unless you do not have access to an option, in which case it is disabled. Workflow may also be disabled if it has not been configured:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="view.png" alt="View Icon" /></td>
<td>View</td>
<td>Performs Enabled View based on selected applet.</td>
</tr>
<tr>
<td><img src="capture.png" alt="Capture Icon" /></td>
<td>Capture</td>
<td>Initiates capture process.</td>
</tr>
<tr>
<td><img src="batch.png" alt="Batch Icon" /></td>
<td>Batch</td>
<td>Opens Batch View grid.</td>
</tr>
<tr>
<td><img src="search.png" alt="Search Icon" /></td>
<td>Search</td>
<td>Opens Document Search grid.</td>
</tr>
<tr>
<td><img src="workflow.png" alt="Workflow Icon" /></td>
<td>Workflow</td>
<td>Opens Workflow grid.</td>
</tr>
</tbody>
</table>

4. **Status Bar**
   - The **ImageNow Status Field** provides status on documents as they are routed and reviewed in workflow. The status bar also contains a set of customizable workflow alarm mechanisms to alert users and administrators as items fill the queues.
Name | Statistic
--- | ---
Work Queue | Name of work queue and the number of items contained in it.
Idle | Number of idle items in the selected work queue.
Working | Number of working items in the selected work queue.
On Hold | Number of items on hold in the selected work queue.

Check your ImageNow version

You can check the ImageNow Client version by selecting the Help menu, and then clicking About ImageNow. To check your ImageNow Server version, use one of the following methods:

- For Windows, in Windows Explorer, open the [drive:]\inserver54\bin folder, right-click the inserverA.exe file, and then select Properties. In the inserverA.exe Properties dialog box, on the Version tab, the File version displays the ImageNow Server version. For example, if 5.41.3.0 appears as the product version, the product is ImageNow, version 5.41 SP3.
- For UNIX, change directories to the bin directory where the ImageNow executables are located. In a window that accepts command prompts, check the version with the command:

  `inservera -v`.

Scanners supported by ImageNow

ImageNow is compatible with a wide variety of scanners. The one you choose depends on your volume and paper handling requirements. A Perceptive Software, Inc., (PSI) scanner list of recommended scanner options can be found on the ImageNow Web site at http://www.imagenow.com/PDFs/other/Scanners.pdf. For additional information, contact your PSI representative.

Disconnect from ImageNow Server

To disconnect from the ImageNow Server, on the Connect menu, click Disconnect.

The toolbar on the ImageNow Client control bar will become dimmed, indicating that you are disconnected. To reconnect to the ImageNow Server, on the Connect menu, click Connect As and complete the log-in procedure.
Exit ImageNow

To close the current session and exit ImageNow, on the Connect menu, click Exit or click the Close button.

To begin another ImageNow session, you will need to start the program again and go through the login procedure.

Note: It is not necessary to disconnect from the server prior to exiting ImageNow.

Getting Help

About the ImageNow Help system

The ImageNow Help system is a compilation of Help topics that are designed to assist users in the completion of their tasks in ImageNow. The content contained in the Help system covers functionality and features that are built into or used by the ImageNow system. Good Help systems advocate for the customer and aim to translate any difficult areas into the customer's language so that he or she may easily identify the topics needed and complete steps successfully.

The content in ImageNow Help is categorized into four types of Help topics or card types: Procedure, Concept, Reference, and Troubleshooting. The majority of information in any Help system is procedurally based; however, the ImageNow Help system aims to keep you on task by separating out information that is not step-by-step.

When you are working in the ImageNow interface and are not sure how to move forward with the next step, open Help, and ask your question. An intelligent result set of answers will return, from which you can choose the type of help you want. The goal of the ImageNow Help system is to provide you with the answers you need that are documented in a manner that is easy to read, conscious of your time, and ensures that you have a successful experience in the Help.

Topic titles are your clue

Procedure topics: Begin with an imperative verb cue and the topics almost always contain numbered steps that walk you through completing the task that is reflected in the topic title. For example, "Copy a Capture Profile." Copy is the action, and the Capture Profile is being acted upon.

Concept topics: Begin with "About" or "What is..." Conceptual topics typically cover a feature area or subsystem, and aim to give you just the conceptual sound-bites you need to make sense of all the procedures that are documented for that area. Remember, Help systems are not manuals; they are not online books. The ImageNow Help system is optimized to answer a question that you have in the moment while working with ImageNow. Concepts and reference information aim to support you in the completion of tasks in a timely manner.
Reference topics  Are positioned as a noun phrase or string such as "Shortcut Keys" or "OCR Recognition Agent methods and modules." Reference topics contain tables of information that you can look up in order to find a description for how a particular user interface element or script works in ImageNow. Concepts and reference information aim to support you in the completion of tasks in a timely manner. As appropriate, you will be directed to the ImageNow Web site for additional reference material.

Troubleshooting topics  Begin with "Troubleshoot" and outline in first-person statements the problem you may be having, and then documents are a solution, typically in step-by-step format. The troubleshooting topic type assumes that the user has tried a task and not completed it successfully, that the user has knowledge about the feature area or task he or she is trying to complete. Regular procedure cards do not assume that a first attempt has been made to complete the task, and steps are documented from start to finish for all levels of users.

More about ImageNow Help

Perceptive Software, Inc., builds Help and other documentation files for each new product release, and regularly publishes Help to www.imagenow.com. Go to the Support Portal, browse to the Documentation section, and then click the associated hyperlink to view the latest Help for the products you run. Optionally, from the ImageNow Client via the ImageNow Help menu, you can elect to retrieve Help directly from the web site, and not the the .chm file residing locally on your computer. In ImageNow, some Help is scoped or focused to provide information on just that area you are working in. For example, when you need help about how to add a script to a workflow queue, from the iScript Editor, an iScript Help file is available along with the larger ImageNow Administrator Help file.

Get ImageNow Help on the Web

When you choose Help from your ImageNow product, this option lets you get Help directly from http://www.imagenow.com. To get the most up-to-date Help, it is recommended that you get Help on the Web.

1. On the Settings menu, click Options.
2. Click the General tab.
3. In the Online Help section, select the Launch online help files from ImageNow.com check box, and then click OK.

Note  Clear the Launch online help files from ImageNow.com check box to use the Help files installed on your computer.

Contact technical support

At Perceptive Software, Inc., supporting our customers is our top priority. We have always prided ourselves on being able to provide a high level of service to our customers around the world. With increased demand and improvements in technology, Perceptive Software is making strides to greatly improve support services across the board. Our Support Portal web site is evidence of our continuing commitment to provide the very best technical support services to our customers. Our telephone support services are available during normal business hours (7:00 A.M. - 7:00 P.M. CST).

You must be a registered user to access Perceptive Software technical product support services. Product support is subject to Perceptive Software prices, terms, and conditions in place at the time the service is used. When contacting Product Support, provide the following information:

- Your name, company name, and phone number.
- Version of ImageNow.
- Type of operating system (for example, Microsoft Windows XP).
• Third-party software being used in conjunction with ImageNow (for example, scanner drivers, optical file systems).
• Complete description of the issue, including steps to reproduce it.
• Exact wording of any error messages displayed when you encountered the problem.
• Steps taken to resolve the problem.
• All previous e-mail threads with Perceptive Software about the issue, if any.

Locations

Perceptive Software is the world's leading manufacturer of image enabling tools for document imaging and management solutions. Perceptive Software is widely recognized as a technology leader in integrating document imaging with existing applications, providing a whole new way for organizations to leverage their investment. Contact Perceptive Software to find out about the latest of the ImageNow family of products, upgrade options, prices, and more. If you have a technical question or problem, contact Product Support.

Perceptive Software, Inc., Headquarters
North America Customers

| Address: | Perceptive Software, Inc.  
22701 West 68th Terrace  
Shawnee, Kansas  66226  
USA |
|---|---|
| Telephone: | (800) 941-7460  
(913) 422-7525 |
| Fax: | (913) 422-3820 |
| Web Site: | www.imagenow.com |
| Support Web Site: | support.imagenow.com |
| Product Support: | support@imagenow.com |
| Sales and Info: | info@imagenow.com |
| Business Issues: | accounting@imagenow.com |
### Perceptive Software Inc., UK Ltd.
#### European Customers

| Address          | Venture House  
|------------------|-----------------  
|                  | Arlington Square  
|                  | Downshire Way  
|                  | Bracknell  
|                  | Berkshire RG12 1WA  
|                  | United Kingdom  
| Telephone:       | (44) (0) 1344 742849  
| Fax:             | (44) (0) 1344 742877  
| Web Site:        | www.imagenow.com  
| Support Web Site: | support.imagenow.com  
| Product Support: | eurosupport@imagenow.com  
| Sales and Info:  | euroinfo@imagenow.com  
| Business Issues: | admin@imagenow.com  

### Perceptive Software Inc., Australia
#### Australasia Customers

| Address          | 1010 Doncaster Road  
|------------------| East Doncaster Victoria 3109  
|                  | Australia  
| Telephone:       | (61) (3) 9842 4976  
| Fax:             | (61) (3) 9841 0087  
| Web Site:        | www.imagenow.com  
| Support Web Site: | support.imagenow.com  
| Product Support: | support@imagenow.com  
| Sales and Info:  | ausinfo@imagenow.com  
| Business Issues: | admin@imagenow.com  

Shortcuts

Enable the ImageNow tray icon

If you did not select the ImageNow tray icon option during the installation of the client software, follow these steps to make the icon appear in the notification area, at the far right edge of the Taskbar. You can use this icon to customize several shortcut functions. For example, you can set the icon to open the batch view grid when you click the icon while pressing the CTRL key.

1. Log in to the ImageNow Client.
2. On the Settings menu, click Options.
3. In the ImageNow Options dialog box, on the General tab, under Tray Icon, select the Enable Tray Icon check box.
4. In the On list, select one of the following options:
   - normal control bar – control bar displays on the desktop.
   - minimize control bar – control bar displays minimized in the Microsoft Windows taskbar.
   - make control bar invisible – control bar is invisible.
5. In the On mouse click, On ctrl-click, and On alt-click lists, select from the following options, and then click OK.
   - launch – Opens the ImageNow Client Logon window.
   - view – Initiates Enabled View (must have host application open).
   - scan – Opens Batch Scan.
   - batch – Opens Batch View.
   - workflow – Opens Workflow.

   **Note** With this option set to View, and with your host application running, clicking the ImageNow tray icon displays all documents associated with the information currently shown in your host application.

**Tip** You can also right-click the ImageNow tray icon to display the ImageNow tray icon and other shortcuts.

ImageNow shortcut keys

Many ImageNow functions can be performed using shortcut keys. Shortcuts key functions vary depending on which grid or component of ImageNow you are using. The following shortcuts are available:

**General PowerView:**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl + + (number pad)</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Ctrl + - (number pad)</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>F2</td>
<td>Resize Fit Image</td>
</tr>
<tr>
<td>F3</td>
<td>Resize Fit Width</td>
</tr>
</tbody>
</table>
### Getting Started

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4</td>
<td>Resize Fit Height</td>
</tr>
<tr>
<td>Alt + Left Arrow</td>
<td>Rotate Left</td>
</tr>
<tr>
<td>Alt + Right Arrow</td>
<td>Rotate Right</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Pan Image Up</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Pan Image Down</td>
</tr>
<tr>
<td>Ctrl + Up Arrow; Home</td>
<td>Top of Image</td>
</tr>
<tr>
<td>Ctrl + Down Arrow; End</td>
<td>Bottom of Image</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Left Margin</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Right Margin</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Go to Page</td>
</tr>
<tr>
<td>Ctrl + Page Down</td>
<td>Next Page</td>
</tr>
<tr>
<td>Ctrl + Page Up</td>
<td>Previous Page</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>First Page</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Last Page</td>
</tr>
<tr>
<td>F6</td>
<td>Scale To Gray (Toggle)</td>
</tr>
<tr>
<td>Alt + End</td>
<td>Reset Pointer (Disable Current Annotation)</td>
</tr>
<tr>
<td>Ctrl + Click</td>
<td>Select Annotation</td>
</tr>
<tr>
<td>F7</td>
<td>Show Document Keys</td>
</tr>
<tr>
<td>F8</td>
<td>Show Keywords</td>
</tr>
<tr>
<td>F9</td>
<td>Show Pager</td>
</tr>
</tbody>
</table>

### Batch Q/A:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Spacebar</td>
<td>Page OK</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Discard Page</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

### Batch link:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + L</td>
<td>Link Page</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Link Commit</td>
</tr>
<tr>
<td>Ctrl + K</td>
<td>Group and Link</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Discard Page</td>
</tr>
</tbody>
</table>
### End-User Guide

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + H</td>
<td>Hold Page</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

**Batch grid:**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Process Selected</td>
</tr>
<tr>
<td>Del</td>
<td>Delete Selected</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>Ctrl + R; F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Table Control</td>
</tr>
<tr>
<td>Ctrl + I; Alt + Enter</td>
<td>Properties</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Notes</td>
</tr>
</tbody>
</table>

**Search grid:**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>View Selected</td>
</tr>
<tr>
<td>Del</td>
<td>Delete Selected</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>Ctrl + Page Down</td>
<td>Page Down</td>
</tr>
<tr>
<td>Ctrl + Page Up</td>
<td>Page Up</td>
</tr>
<tr>
<td>Ctrl + R; F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Find</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Table Control</td>
</tr>
<tr>
<td>Ctrl + I; Alt + Enter</td>
<td>Properties</td>
</tr>
<tr>
<td>Ctrl + K</td>
<td>Keywords (Notes)</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Column Select Right</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Column Select Left</td>
</tr>
<tr>
<td>Ctrl + Up Arrow</td>
<td>Sort Ascending</td>
</tr>
<tr>
<td>Ctrl + Down Arrow</td>
<td>Sort Descending</td>
</tr>
</tbody>
</table>
Workflow:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Spacebar</td>
<td>Route Item</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Relink Item</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Hold Item</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Next Item</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Item History</td>
</tr>
</tbody>
</table>

Workflow item list:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Process Selected</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>Ctrl + R; F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Table Control</td>
</tr>
<tr>
<td>Ctrl + I; Alt + Enter</td>
<td>Properties</td>
</tr>
</tbody>
</table>

Workflow history:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>Ctrl + R; F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Table Control</td>
</tr>
<tr>
<td>Ctrl + I; Alt + Enter</td>
<td>Properties</td>
</tr>
</tbody>
</table>

ImageNow Toolbars

File toolbar

The PowerView File toolbar contains icons that enable you to perform several application-level controls. These icons coincide with several of the options contained in the PowerView File menu.
The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>Print</td>
<td>Prints the selected document.</td>
</tr>
<tr>
<td>⌨️</td>
<td>E-mail</td>
<td>Attaches copy of the selected document in an e-mail message (requires appropriate e-mail configuration).</td>
</tr>
<tr>
<td>📄</td>
<td>Image Info</td>
<td>Opens Properties dialog box on the selected document.</td>
</tr>
<tr>
<td>📋</td>
<td>Save As</td>
<td>Exports the selected document to be saved under a different name.</td>
</tr>
<tr>
<td>📦</td>
<td>Launch Associated Application</td>
<td>Launches associated application of selected document, such as Microsoft Word, Excel, and Access (if the programs are installed).</td>
</tr>
</tbody>
</table>

Scan toolbar

The PowerView Scan toolbar contains options that enable you to re-scan, save, and discard scanned documents.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📦</td>
<td>Scan</td>
<td>Initiates scanning process.</td>
</tr>
<tr>
<td>⌨️</td>
<td>Re-scan</td>
<td>Re-scans current page.</td>
</tr>
<tr>
<td>📋</td>
<td>Scan Save</td>
<td>Saves current page.</td>
</tr>
<tr>
<td>🗑</td>
<td>Scan Discard</td>
<td>Deletes the current page; displays next page.</td>
</tr>
</tbody>
</table>

Package Scan toolbar

The Package Scan toolbar will only display if Package Scanning has been installed and configured. As part of Package Scanning, the Package Scan toolbar enables you to scan, re-scan, save, and discard scanned documents. The Package Scan toolbar displays when you capture documents. By default, the toolbar is displayed at the bottom of the PowerView window.
The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Capture" /></td>
<td>Capture</td>
<td>Scans the document.</td>
</tr>
<tr>
<td><img src="image" alt="Delete Page" /></td>
<td>Delete Page</td>
<td>Deletes the selected page.</td>
</tr>
<tr>
<td><img src="image" alt="Capture Profile" /></td>
<td>Capture Profile</td>
<td>Selects the Capture Profile to use.</td>
</tr>
<tr>
<td><img src="image" alt="Re-link" /></td>
<td>Re-link</td>
<td>Links (or re-links) the displayed page to a host application record.</td>
</tr>
<tr>
<td><img src="image" alt="Submit" /></td>
<td>Submit</td>
<td>Submits the package to the ImageNow Server.</td>
</tr>
</tbody>
</table>

Search grid toolbar

The Search grid toolbar enables you to find, annotate, and manage documents.

The following options are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File Open" /></td>
<td>File Open</td>
<td>Opens the selected document.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Opens the Print dialog box. This enables you to print a screen capture of the Search grid.</td>
</tr>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export</td>
<td>Opens the Export dialog box. This enables you to export the selected document to a remote location.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
<td>Deletes the selected document.</td>
</tr>
<tr>
<td><img src="image" alt="Notes" /></td>
<td>Notes</td>
<td>Opens the Document Keywords window. This enables you to enter notes about the selected document.</td>
</tr>
<tr>
<td><img src="image" alt="Properties" /></td>
<td>Properties</td>
<td>Opens a detailed listing of information about the selected document.</td>
</tr>
<tr>
<td><img src="image" alt="Find" /></td>
<td>Find</td>
<td>Opens the Quick Search dialog box. This enables you to quickly search individual columns.</td>
</tr>
</tbody>
</table>

(Simple Search only)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Table Control" /></td>
<td>Table Control</td>
<td>Opens the Table Control dialog box. This enables you to customize the Search grid.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh</td>
<td>Re-displays document list including additions, changes, or deletions made since the last time the Search grid was opened.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Lock" /></td>
<td>Toggle Lock</td>
<td>Toggles locking of Search grid data for local sorts and searches.</td>
</tr>
<tr>
<td><img src="image" alt="Page Down" /></td>
<td>Page Down</td>
<td>Loads the next set of documents to the on-screen view.</td>
</tr>
<tr>
<td><img src="image" alt="Page Up" /></td>
<td>Page Up</td>
<td>Loads the next set of documents to the on-screen view.</td>
</tr>
</tbody>
</table>
View toolbar
The PowerView View toolbar contains several icons that enable you to alter the way the document is displayed in PowerView. The icons coincide with several of the options contained in the View menu.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom In</td>
<td>Increases the magnification of the selected page by 2x.</td>
</tr>
<tr>
<td></td>
<td>Zoom Out</td>
<td>Decreases the magnification of the selected page by 1/2x.</td>
</tr>
<tr>
<td></td>
<td>Rotate Left</td>
<td>Rotates the selected page counterclockwise 90°.</td>
</tr>
<tr>
<td></td>
<td>Rotate Right</td>
<td>Rotates the selected page clockwise 90°.</td>
</tr>
<tr>
<td></td>
<td>Fit Window</td>
<td>Resizes the selected page to fit in the window.</td>
</tr>
<tr>
<td></td>
<td>Fit Width</td>
<td>Resizes the selected page to fit the entire width in the window.</td>
</tr>
<tr>
<td></td>
<td>Fit Height</td>
<td>Resizes the selected page to fit the entire height in the window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zoom Regions</td>
</tr>
</tbody>
</table>

Page viewing toolbar
The PowerView Page toolbar enables you to navigate through pages and documents.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Previous Document</td>
<td>Opens previous document.</td>
</tr>
<tr>
<td></td>
<td>First Page</td>
<td>Opens first page of document.</td>
</tr>
<tr>
<td></td>
<td>Previous Page</td>
<td>Opens previous page of document.</td>
</tr>
<tr>
<td></td>
<td>GoTo Page</td>
<td>Opens a specified page.</td>
</tr>
<tr>
<td></td>
<td>Next Page</td>
<td>Opens next page of document.</td>
</tr>
<tr>
<td></td>
<td>Last Page</td>
<td>Opens last page of document.</td>
</tr>
<tr>
<td></td>
<td>Next Document</td>
<td>Opens next document.</td>
</tr>
</tbody>
</table>
Preview toolbar

As part of workflow processing, the PowerView Preview toolbar enables you to quickly look for and merge matching items in a workflow queue. The Preview toolbar will display when a second item in a workflow queue is opened. By default, the toolbar is displayed in the top right side of the PowerView window.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Merge</td>
<td>Merges with displayed workflow item.</td>
</tr>
<tr>
<td></td>
<td>Previous</td>
<td>Previews previous item in grid.</td>
</tr>
<tr>
<td></td>
<td>Next</td>
<td>Previews next item in grid.</td>
</tr>
</tbody>
</table>

Workflow toolbar

The PowerView Workflow toolbar will display when a document is opened in PowerView Workflow Mode. By default, the toolbar is displayed in the bottom left corner of the PowerView window. The Workflow toolbar contains options that enable you to perform workflow-specific tasks.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Next Item</td>
<td>Displays the next item in the workflow queue.</td>
</tr>
<tr>
<td></td>
<td>Choose Any Item</td>
<td>Allows you to choose any item in the workflow queue.</td>
</tr>
<tr>
<td></td>
<td>Choose Hold Item</td>
<td>Allows you to choose any item previously placed on hold.</td>
</tr>
<tr>
<td></td>
<td>Re-link</td>
<td>Links (or re-links) the selected item to an application record.</td>
</tr>
<tr>
<td></td>
<td>Route Back</td>
<td>Sends the selected item back to the queue from which it came.</td>
</tr>
<tr>
<td></td>
<td>Route</td>
<td>Sends the selected item to the next workflow queue. If there is more than</td>
</tr>
<tr>
<td></td>
<td></td>
<td>one possible subsequent queue, you are prompted to choose.</td>
</tr>
<tr>
<td></td>
<td>Hold</td>
<td>Places the selected item on hold for later processing.</td>
</tr>
<tr>
<td></td>
<td>Cancel</td>
<td>Quits workflow processing.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes the selected item from the queue.</td>
</tr>
<tr>
<td></td>
<td>History</td>
<td>Displays the selected item’s workflow history.</td>
</tr>
<tr>
<td></td>
<td>Forms</td>
<td>Displays a list of workflow items associated with the current queue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(not available in all installations).</td>
</tr>
</tbody>
</table>
Annotation toolbar

In PowerView, the Annotation toolbar offers a wide variety of tools so you can add highlights or notes to document images. These annotations are attached to the document image and can be deleted after the image is recalled. Annotations support is available with TIFF, BMP, and JPG document images only.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Stamp]</td>
<td>Stamp</td>
<td>Stamps various messages (Approved, Confidential, and so forth.) on the document image. Can be used to create customized stamps.</td>
</tr>
<tr>
<td>![Sticky Note]</td>
<td>Sticky Note</td>
<td>Places a &quot;note&quot; (text box) on the document image to which comments can be added.</td>
</tr>
<tr>
<td>![Text]</td>
<td>Text</td>
<td>Enters text on the document image.</td>
</tr>
<tr>
<td>![Highlight]</td>
<td>Highlight</td>
<td>Highlights selected areas of the document image.</td>
</tr>
<tr>
<td>![Check]</td>
<td>Check</td>
<td>Places a checkmark on the document image.</td>
</tr>
<tr>
<td>![Redline]</td>
<td>Redline</td>
<td>Draws a line on the document image.</td>
</tr>
<tr>
<td>![Arrow]</td>
<td>Arrow</td>
<td>Draws an arrow on the document image.</td>
</tr>
<tr>
<td>![Solid Mask]</td>
<td>Solid Mask</td>
<td>Blocks out selected areas of the document image.</td>
</tr>
<tr>
<td>![Hollow Mask]</td>
<td>Hollow Mask</td>
<td>Highlights selected areas of the document image with a rectangular outline.</td>
</tr>
<tr>
<td>![Hollow Circle Mask]</td>
<td>Hollow Circle Mask</td>
<td>Highlights selected areas of the document image with a circular outline.</td>
</tr>
<tr>
<td>![OLE Item]</td>
<td>OLE Item</td>
<td>Embeds sounds, pictures, or any other object supported by your system into the document image.</td>
</tr>
<tr>
<td>![Toggle Show Annotations]</td>
<td>Toggle Show Annotations</td>
<td>Shows or hides annotations made on the document image.</td>
</tr>
<tr>
<td>![Move/Resize]</td>
<td>Move/Resize</td>
<td>Moves or resizes annotations placed on the document image.</td>
</tr>
<tr>
<td>![Annotation Off]</td>
<td>Annotation Off</td>
<td>De-selects the currently selected annotation.</td>
</tr>
</tbody>
</table>
Batch QA toolbar

The Batch Q/A toolbar will display when a batch is opened in PowerView Batch Q/A Mode. By default, the toolbar is displayed in the bottom left corner of the PowerView window.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Page OK" /></td>
<td>Page OK</td>
<td>Approves the selected page as Q/A complete.</td>
</tr>
<tr>
<td><img src="image" alt="Discard Page" /></td>
<td>Discard Page</td>
<td>Removes the selected page from a batch.</td>
</tr>
<tr>
<td><img src="image" alt="Commit Batch" /></td>
<td>Commit Batch</td>
<td>Approves all the pages in the batch as Q/A complete.</td>
</tr>
<tr>
<td><img src="image" alt="Suspend Batch" /></td>
<td>Suspend Batch</td>
<td>Suspends current batch for later processing and allows you to choose another batch to process.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Batch Processing" /></td>
<td>Stop Batch Processing</td>
<td>Stops batch processing. All work is saved and PowerView is closed.</td>
</tr>
<tr>
<td><img src="image" alt="Rescan" /></td>
<td>Rescan</td>
<td>Replaces existing page with a newly scanned page.</td>
</tr>
</tbody>
</table>

Batch Link toolbar

The Batch Link toolbar will display when a batch is opened in PowerView Batch Link Mode. By default, the toolbar is displayed in the bottom left corner of the PowerView window.

The following actions are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Link Page" /></td>
<td>Link Page</td>
<td>Links the selected page to the application record (as defined in the LearnMode Applet).</td>
</tr>
<tr>
<td><img src="image" alt="Group and Link" /></td>
<td>Group and Link</td>
<td>Links the selected page using the same DocKeys as the previous page.</td>
</tr>
<tr>
<td><img src="image" alt="Link Commit" /></td>
<td>Link Commit</td>
<td>Links the selected page with the DocKeys from the Document Keys window.</td>
</tr>
<tr>
<td><img src="image" alt="Discard Page" /></td>
<td>Discard Page</td>
<td>Removes the selected page from the batch.</td>
</tr>
<tr>
<td><img src="image" alt="Hold Page" /></td>
<td>Hold Page</td>
<td>Places the selected page on hold for later processing.</td>
</tr>
<tr>
<td><img src="image" alt="Suspend Batch" /></td>
<td>Suspend Batch</td>
<td>Suspends batch for later processing and allows you to choose another batch to process.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Batch Processing" /></td>
<td>Stop Batch Processing</td>
<td>Stops batch processing. All work is saved and PowerView is closed.</td>
</tr>
</tbody>
</table>
Customize toolbars

PowerView toolbars can be customized to meet your specific needs. You can open all of the toolbars at once or display a few of the individual icons. In addition, you can create a new toolbar from scratch using any of the icons you want. By default, the toolbars that are already selected are usually the only ones functional in the current mode. Use the instructions below to customize toolbars and icons.

Show additional toolbars in selected PowerView mode

Adding additional toolbars will only appear in the selected PowerView Mode you are currently using.

1. In the **PowerView** window, on the **File** menu, point to **Settings**, and then click **Customize Toolbars**.
2. In the **Toolbars** dialog box, select the toolbars that you want to display in the current mode of PowerView. Uncheck the toolbars that you do not want to display, and then click **OK**.
3. To save the changes, on the **File** menu, point to **Settings**, and then click **Save Toolbar Positions**. If you do not save, your changes will be lost when PowerView is closed.

**Note** Toolbars or icons that are dimmed are not available in the current PowerView mode. Certain toolbars are not functional in some modes. In the pop-up menu, dimmed toolbars indicate the toolbars are not functional in the current mode.

Customize individual toolbar icons

1. In the **PowerView** window, on the **File** menu, point to **Settings**, and then click **Customize Toolbars**.
2. In the **Toolbars** dialog box, click **Customize**.
3. In the **Customize** dialog box, click the **Commands** tab.
4. Select a toolbar category and click on the individual icon that appears to the right. In the **Description** field, a brief description is given for each icon.
5. Select the individual icon you want to add to an existing PowerView toolbar. Drag the icon to the PowerView toolbar you want it to be in. The individual icon is added to the selected toolbar (the icon is not removed from its original toolbar).
6. Click **OK**.
7. To save the changes, on the **File** menu, point to **Settings**, and then click **Save Toolbar Positions**. If you do not save, your changes are lost when PowerView is closed.

**Note** Toolbars or icons that are dimmed are not available in the current PowerView mode. Certain toolbars are not functional in some modes. In the pop-up menu, dimmed toolbars indicate the toolbars are not functional in the current mode.

Add a new toolbar with customized icons

1. In the **PowerView** window, on the **File** menu, point to **Settings**, and then click **Customize Toolbars**.
2. In the **Toolbars** dialog box, click **Customize**.
3. In the **Customize** dialog box, verify that the **Toolbars** tab is displayed.
4. Click **New**.
5. In the **New Toolbar** dialog box, type the name of the new toolbar.
6. Click **OK**. The new toolbar will display in PowerView.
7. Click the **Commands** tab.
8. Select a toolbar category, and then click the individual icon that appears to the right. In the **Description** field, a brief description is given for each icon.
9. Select the individual icon you want to add to the new toolbar. Drag the icon to the empty toolbar. The
individual icon is added to the new toolbar (the icon is not removed from its original toolbar).

10. Repeat steps 8 and 9 for each additional icon you want to add. You can add icons to the new toolbar
from any of the existing toolbars.

11. Click OK.

12. To save the changes, on the File menu, point to Settings, and then click Save Toolbar Positions. If
you do not save, your changes are lost when PowerView is closed.

Reset toolbars
1. In the PowerView window, on the File menu, point to Settings, and then Reset Toolbars.
2. In the PowerView confirmation dialog box, click OK.

Move or resize toolbars
The PowerView toolbars have the ability to 'undock' and reposition anywhere in the PowerView window.
By default, all of the toolbars are 'docked' in the PowerView window. Use the instructions below to move,
resize, or reset the PowerView toolbars.

Notice that each toolbar has a pair of dotted lines on its left edge. These lines can be used as a handle to
grab the toolbar and undock it. Changes made to the toolbar settings must be saved in order to be
available next time PowerView is opened.

Reposition toolbars
1. Place your mouse over the toolbar handle. Click and hold the mouse button.
2. Drag the toolbar away from the docked position. As you move the mouse, a rectangle is drawn
representing the size and position of the toolbar you are moving.
3. Move the toolbar to the new location. Release the mouse button. The toolbar will be repositioned in
the new location. You can now move this toolbar anywhere on the desktop. Notice that if you drag the
window near an edge of the window, PowerView will attempt to re-dock the toolbar in the window.

Note To prevent the toolbar from docking when it nears the edge of the window, press CTRL as you
release the mouse button.
Resize toolbars

1. Undock the toolbar you want to resize. (Click on the handle and drag the toolbar away from the docked position.)
2. Place your mouse pointer on border of the toolbar. The mouse pointer will change to a set of resize arrows.
3. Click and drag the mouse to resize the shape of the toolbar window.

Reset toolbars to their original defaults

1. In the PowerView window, on the File menu, point to Settings, and then click Customize Toolbars.
2. In the Toolbars dialog box, click the Reset button.
3. Click the Close button. The toolbars will reset to their original defaults the next time PowerView is opened.
Viewing Documents

About viewing a document

By using ImageNow, you can quickly search and view documents that are linked to records in your primary or host software program. You can view a document using the View icon on the ImageNow Client control bar.

The principle function of a document imaging system is to quickly and accurately deliver desired documents to a user or group of users. One of the key features of ImageNow is its ability to integrate with your host system to capture and deliver document images. The process of viewing scanned documents from within your host system is called Enabled View.

If you are reviewing a record within your host system, you may want to have instant access to all scanned documents that support that record. For example, if you are reviewing an account record, you may need to see other documents that are related to that account. By clicking on the View icon on the ImageNow Client control bar, all of the related documents are displayed for you.

Using the View icon

The View icon initiates a search of records that have already been view-enabled (linked) by your host system. The search takes information from the open host application and cross-references it with records linked and stored within ImageNow. The Document Search grid will display any documents found that match the DocKeys defined in the host application.

Understanding Enabled View

Enabled View enables you to view scanned documents that have been linked to your host application. ImageNow integrates with your existing host system by reading information from the host system screen and using it to index and retrieve scanned documents (and other stored objects).

This means that as you are working within your host system, you can view scanned documents that have been linked to the current host record.

The different viewing modes in PowerView

PowerView has several individual modes for viewing and processing objects. Each mode is designed for specific tasks and has its own toolbar. Though PowerView will always look similar, the options and toolbars available will change with each different mode.

You do not need to select PowerView modes, specific modes of PowerView will automatically open based on the task you are performing. For example, if you are viewing objects, View Mode will open; if you are processing a workflow item, Workflow Mode will open, and so forth. The current PowerView Mode is always displayed in the PowerView title bar.

The PowerView modes and their functions are:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Opened By</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Mode</td>
<td>Opening a document with the View icon</td>
<td>View and annotate documents.</td>
</tr>
<tr>
<td>Q/A Mode</td>
<td>Opening a &quot;Scan/Import Completed&quot; batch from Batch View grid.</td>
<td>Review each page of a batch to make sure it was captured properly. Annotation possible.</td>
</tr>
</tbody>
</table>
### End-User Guide

<table>
<thead>
<tr>
<th>Mode</th>
<th>Opened By</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Mode</td>
<td>Opening a &quot;QA Completed&quot; batch from Batch View grid.</td>
<td>Links each page of a batch using selected LearnMode Applet. Annotation possible.</td>
</tr>
<tr>
<td>Workflow Mode</td>
<td>Opening an item from the Workflow grid.</td>
<td>Review, re-link, and route documents. Annotation possible.</td>
</tr>
<tr>
<td>Preview Mode</td>
<td>Opening a workflow item from the Workflow grid in Preview Mode.</td>
<td>Preview or merge workflow item being processed. Annotation possible.</td>
</tr>
<tr>
<td>Scan Mode</td>
<td>Scanning documents.</td>
<td>Review, save, rescan, or discard scanned document. Annotation possible.</td>
</tr>
<tr>
<td>Package Mode</td>
<td>Scanning documents (only available if Package Scanning has been installed and configured).</td>
<td>Scan, sort, and link numerous documents simultaneously.</td>
</tr>
</tbody>
</table>

**Note** It is possible to open a single document in multiple PowerView modes at the same time (except for Batch Q/A, Batch Link, and Scan modes). You can simultaneously view the same document in the View, Search, Workflow, and Preview Modes.

### About PowerView windows

There are several other components within PowerView to help you navigate, manage, and view documents.

#### Pager window

The PowerView Pager enables you to organize the various pages of a multi-page document. To access the Pager, in the PowerView window, on the View menu, click Pager, or press **F9**. By default, the Pager will display under the document window.

![Page Organizer](image)

Each page icon represents each page of the document. Each page icon contains a menu that has several options available for the individual page. Right-click the page icon of the individual page you want to modify. The following menu will display:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cuts selected page.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies selected page.</td>
</tr>
<tr>
<td>Copy to New Doc</td>
<td>Copies selected page to a new document.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Move to New Doc</td>
<td>Moves selected page to a new document.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Attaches copy of selected page as an e-mail attachment.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes or removes selected page.</td>
</tr>
</tbody>
</table>

**Document Keys window**

The PowerView **Document Keys** window contains information used to index and retrieve captured objects. To access the **Document Keys** window, in the **PowerView** window, on the **View** menu, click **Document Keys**, or press **F7**. By default, the **Document Keys** window will display to the right of the document window.

As data is gathered into ImageNow, it is stored in one or more of the Document Keys, or DocKeys. The DocKeys are the ImageNow index fields. The data in these fields is used by ImageNow to index and retrieve captured objects.

There are as many as six DocKeys available within ImageNow. The first field, **Drawer**, is used to separate large groups of captured objects. Security can be applied to a drawer to allow access only to certain users.

In addition to the Drawer field, there are five DocKey fields available to store information on captured objects. The DocKey fields are customizable to fit any business model. The most important part of a DocKeys structure is that each individual object is uniquely defined.

**Keywords window**

The PowerView **Keywords** window contains information used to index and retrieve captured objects. To access the **Keywords** window, in the **PowerView** window, on the **View** menu, click **Keywords**, or press **F8**. By default, the **Keywords** window will display to the right of the document window.
The Keywords window can be used to enter and view notes or other relevant information about the object.

You can also automatically add the time and date you reviewed the object to the Keywords window. To add a date stamp, click the Date Stamp icon in the top left corner of the Keywords window.

Once notes are entered, the information can be viewed in the Search grid. The Keywords column displays the information entered into the Keywords window.

**PowerView status bar**

The PowerView status bar contains information about the status of documents being viewed and processed in PowerView. The PowerView status bar is located at the bottom of the PowerView window. In workflow, the status bar can also be used to alert users when an item has been sitting in a workflow queue for too long.
Add or view notes on a document

The grid Notes icon enables you to quickly add notes to a document.

1. In the Document Search window, select the document to which you want to add notes.
2. Click the Notes icon, or on the Edit menu, click Notes.
3. In the Document Keywords dialog box, add or view notes, and then click OK.
View a document
ImageNow enables you to quickly search for and view linked documents. The View icon initiates a search of records that have already been view-enabled (linked) by your host system. The search takes information from the open host application and cross-references it with records linked and stored within ImageNow. The Document Search grid will display any documents found that match the DocKeys defined in the host application.

1. Open the record inside your host application against which you want to view documents.
2. Open ImageNow Client, then on the ImageNow Client control bar, verify your applet name, and then click the View icon.

Notes
- The applet determines which defined DocKeys are searched within the host application.
- When you are finished viewing a document, simply close the PowerView window. You do not need to click Save.
- If multiple matching documents are found (different document types for the same record), the matches will be displayed in a list in the Document Search grid. Double-click the selected document that you want to view. A copy of the document is opened and displayed inside PowerView View Mode.

View a document in its original application
You can launch a PowerView document inside its associated application, such as a Microsoft Word document, where Word is installed on your computer. Any changes you make to the file will not be saved in ImageNow. To save changes in ImageNow, import the file and either append or replace the existing ImageNow document. The Launch Associated App button is unavailable when you want to view TIFF files.

- Open the document you want into PowerView, and then on the File toolbar, click the Launch Associated App icon.

Open all pages of a document at once
Each document opened is placed in a separate PowerView window. ImageNow is capable of supporting up to 99 simultaneous PowerView windows.

1. Open a document that consists of more than one page.
2. In the PowerView window, on the Window menu, select Open All From Server.

Invert a document image
In PowerView, you can invert a document image to display the opposite colors.

1. Open the document image you want to invert.
2. On the View menu, click Invert.
Show XY coordinates
1. Open a document image in PowerView.
2. In the PowerView window, on the View menu, click Show XY Coords.
3. Roll the cursor over the image. The XY Coordinates will display in the bottom left corner of the PowerView status bar.

Note To hide the XY Coordinates, on the View menu, uncheck Show XY Coords.

Resize a document
1. Open the document image you want to resize.
2. In the PowerView window, on the View menu, point to Resize, and then select the resize option you want.

Rotate a document
1. Open the document image you want to rotate.
2. In the PowerView window, on the View menu, point to Rotate, and then select the option you want.
3. Optional: On the File menu, point to Settings, and then click Save Image Rotation to Server.

Zoom in and out of a document
1. Open the document image for which you want to zoom in or out.
2. In the PowerView window, on the View menu, click Zoom In or Zoom Out.
3. Repeat step 2 to continue to zoom in or out.

Tip
- Follow these steps to zoom in on a particular region of a document.
  1. Position the cursor near the region on the document where you want to zoom.
  2. Click and hold the right mouse button (the cursor appears as a magnifying glass). Drag the magnifying glass around the area you want magnified, and then release the mouse button.
- To quickly zoom in on a document, on the View menu, point to Resize, and then click Maximum Resolution.

Defining views

Set view options
1. On the ImageNow control bar, on the Settings menu, click Options.
2. In the ImageNow Options dialog box, click the PowerView tab.
3. Under General, select any of the following:
   - When opening a document from search window, launch new viewer - Opens a separate window each time a new document is opened from the Search grid. If this option is not selected, PowerView displays only the currently selected document in one viewer.
   - When opening a document from an "enable" view request, launch new viewer - Opens a separate window for each Enabled View request (clicking the View icon). If this option is not selected, PowerView displays only the currently requested document in one viewer.
When clicking the next or previous document buttons, launch new viewer - Determines whether the Next and Previous buttons on the Page toolbar open each page of a multi-page document in the same viewer or in a new viewer.

4. Under Document Page Prefetch, select one of the following:
   - "Image-Enable" View - Opened from the View icon on the control bar.
   - Search Dialog - Opened from the Search grid.
   - Workflow Operations - Opened from the Workflow grid.
   **Note** Changes only apply to the selected viewer. Each viewer must be customized individually.

5. In the On Document Open retrieve page(s) box, set the number of pages to be retrieved, and then select one of the following to determine from where to retrieve:
   - From the first page of the document - Retrieves the first page of the document.
   - From the last page of the document - Retrieves the last page of the document.
   - Starting with page number - Selects a starting page for documents to be retrieved.

6. In the On Get Next Page retrieve page(s) box, set the number of pages to be viewed when the Next Page icon is clicked in PowerView, and then click OK.

7. To change the default of 100 maximum open pages, navigate to [drive:]\Program Files\ImageNow, and then open the imagenow.ini file in a text editor. Under the [PowerVu Settings] section, add the following settings:
   - MaxOpenPagesEnabled=1
   - MaxOpenPages=X (where X is any number up to 100)

8. Save the file, and then close it.

**Save and use a zoom region**

In PowerView, there are times when you may need to zoom in on small regions of a document image. For example, you may need to verify a signature. Instead of zooming to those regions manually, you can save a specific zoom region.

1. In PowerView, zoom on a region in the document.
2. On the File menu, point to Settings, and then click Save View.
3. In the Save View dialog box, type a name for the new View, and then click OK.
4. To use a saved zoom region, in the View toolbar list, click the View name you created.

**Set a default view**

1. In the PowerView window, on the File menu, point to Settings, and then click Edit View(s).
2. In the Edit Views dialog box, select the View you want to set as a default.
3. In the Viewer Mode list, select the PowerView Mode for which you want to set the View default.
4. Click the Set Default button. The PowerView Mode will display in the Default for mode list to the right of the View in the View list.
   **Note** Some views can act as defaults for several PowerView Modes simultaneously. Repeat the steps to set a view for a second PowerView mode.
Automatically tile open documents

Automatic tile enables you to simultaneously view all the pages of a multiple-page document in the PowerView window side by side. Each page is opened within its own sub-window that can be resized, minimized, maximized, or repositioned.

1. Open the document you want to view.
2. In the PowerView window, on the View menu, select Automatic Tile.
3. On the Window menu, select how you want to tile the pages.

Turn on or off grayscale

The gray scale option is only available for document images.

1. Open the document image you want to view as gray scale.
2. In the PowerView window, on the View menu, click Gray Scale. A checkmark means that gray scale is turned on.

View document properties

Document properties include the ability to view document ID, created and modified information, index keys, workflow history, and file type.

Do one of the following:

- In the Search or Workflow grid, right-click on a document, and then click Properties.
- In PowerView, on the File menu, click Properties.
Customizing grids

Add or remove a grid column
In the Batch, Search, and Workflow grids, the Table Control icon enables you to customize, edit, and reorder the column headers.

1. Open the grid you want to customize.
2. Click the Table Control icon.
3. In the Table Control dialog box, select the column headers to display by selecting the corresponding check boxes, and then click OK.

Reorder a grid column
In the Batch, Search, and Workflow grids, the Table Control icon enables you to customize, edit, and reorder the column headers.

1. Open the grid you want to customize.
2. Click the Table Control icon.
3. In the Table Control dialog box, select the column header you want to move, and then drag it to the location you want.
4. Click OK.

Refresh a grid
1. Open the grid that you want to refresh.
2. On the ImageNow Client control bar, click one of the following icons:
   - Batch icon
   - Search icon
   - Workflow icon
3. On the View menu, click the Refresh icon.

Choose grid column headers
In the Batch, Search, and Workflow grids, the Table Control icon enables you to customize, edit, and reorder the column headers.

1. Open the grid you want to customize.
2. From the grid, right-click the column headers. A list of available column header sets will display.
3. Select the column header set you want to use. The column headers will display the new column header set.

**Verify a document move**

This option enables you to be prompted with a dialog box to verify when a file is moved during Search grid editing.

1. On the Settings menu, click Options.
2. In the ImageNow Options dialog box, on the Search tab, in the General section, select the Verify document move check box, and then click OK.

**Batch, Search and Workflow grid options**

The Batch, Search, and Workflow grids each have tools that enable you to find, annotate, and manage documents in ImageNow. Each grid is used for a different purpose:

<table>
<thead>
<tr>
<th><strong>Batch View Grid</strong></th>
<th><strong>Search Grid</strong></th>
<th><strong>Workflow Grid</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Entry point for scanned and imported objects.</td>
<td>• Storage location of documents once they have been Q/A and linked.</td>
<td>• Workflow environment consisting of Start and Work Queues.</td>
</tr>
<tr>
<td>• Quality assure documents.</td>
<td>• Search stored documents.</td>
<td>• Route documents to various queues.</td>
</tr>
<tr>
<td>• Link documents.</td>
<td>• Sort and merge stored documents.</td>
<td>• Relink documents.</td>
</tr>
<tr>
<td>• Send linked documents to Search grid.</td>
<td>• Send documents to workflow.</td>
<td></td>
</tr>
</tbody>
</table>

Each grid has a similar toolbar:

**Batch View grid toolbar**

![Batch View grid toolbar]

**Search grid toolbar**

![Search grid toolbar]

**Workflow grid toolbar**

![Workflow grid toolbar]
The following options are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open]</td>
<td>Open</td>
<td>Opens the selected document.</td>
</tr>
<tr>
<td>![Print]</td>
<td>Print</td>
<td>Opens the Print dialog box. This enables you to print a screen capture of the grid.</td>
</tr>
<tr>
<td>![Export]</td>
<td>Export</td>
<td>Opens the Export dialog box. This enables you to export the selected document to a remote location.</td>
</tr>
<tr>
<td>![Delete]</td>
<td>Delete</td>
<td>Deletes the selected document.</td>
</tr>
<tr>
<td>![Notes]</td>
<td>Notes</td>
<td>Opens the Document Keywords window. This enables you to enter notes about the selected document.</td>
</tr>
<tr>
<td>![Properties]</td>
<td>Properties</td>
<td>Opens a detailed listing of information about the selected document.</td>
</tr>
<tr>
<td>![Find]</td>
<td>Find</td>
<td>Opens the Quick Search dialog box. This enables you to quickly search individual columns.</td>
</tr>
<tr>
<td>![View]</td>
<td>View</td>
<td>Sorts and displays the listed documents by their status. (Batch View grid only)</td>
</tr>
<tr>
<td>![Table Control]</td>
<td>Table Control</td>
<td>Opens the Table Control dialog box. This enables you to customize the grid.</td>
</tr>
<tr>
<td>![Refresh]</td>
<td>Refresh</td>
<td>Re-displays document list including additions, changes, or deletions made since the last time the grid was opened.</td>
</tr>
<tr>
<td>![Toggle Lock]</td>
<td>Toggle Lock</td>
<td>Toggles locking of Search grid data for local sorts and searches. (Search grid only)</td>
</tr>
<tr>
<td>![Page Down]</td>
<td>Page Down</td>
<td>Loads the next set of documents to the on-screen view. (Search grid only)</td>
</tr>
<tr>
<td>![Page Up]</td>
<td>Page Up</td>
<td>Loads the next set of documents to the on-screen view. (Search grid only)</td>
</tr>
</tbody>
</table>
Printing

About printing
ImageNow lets you set up your printer, preview a document, print one or more documents at a time, and print attributes of document such as DocKeys and the document title as it appears in the PowerView window title bar. Before you can print any document properties, you must edit the imagenow.ini file using settings that are documented in "Print document keys and title."

ImageNow Printer is another print feature provided by Perceptive Software, Inc. It allows you to bypass the print and scan process in order to quickly get documents into ImageNow. ImageNow Printer imports the documents by grabbing them electronically from the repositories you specify, converting them to TIFF files, and storing them in ImageNow.

Print preview a document
1. In PowerView, open the document you want to print.
2. On the File menu, click Print Preview.
3. View the document using the options provided, and then click Print or Close.

Print one or more documents
1. From the Batch grid, right-click the document(s) you want to print, and then click Print.
2. In the Print dialog box, select to print with or without annotations, and then click OK.

Set up a printer
1. Open PowerView.
2. From the File menu, click Printer Setup.
3. In the Print Setup dialog box, select the settings you want, and then click OK.

Print document keys and title
You can print a document from PowerView that displays the associated document keys and title at the top of the printed page.

1. Navigate to the [drive:]\Program Files\ImageNow folder, and then edit the imagenow.ini file.
2. Add the following section to the bottom of the file:
   [PowerVu Settings]
   PrintTitle=1

   Possible settings for the PrintTitle parameter are:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>Print document keys</td>
</tr>
<tr>
<td>2</td>
<td>Print title of the PowerView window</td>
</tr>
<tr>
<td>3</td>
<td>Print both document keys and title</td>
</tr>
</tbody>
</table>
3. Save and close the file.
4. Open your document in PowerView, and then print it.

**Import a document using ImageNow Printer**

1. Open the document you want to import into ImageNow, click **File**, and then click **Print**.
2. Set the printer name to **ImageNow Printer**, and then click **OK**.
   
   **Note** If you have more than one ImageNow Printer Capture Profile set up, the **ImageNow Print** dialog box appears. From the **CaptureNow Profile** list, click the ImageNow Printer profile you want, and then click **OK**. CaptureNow "prints" the document into ImageNow.

3. In the **PowerView - Scan Mode** window, verify image quality and make any changes you want using the options available to you in PowerView.
About processing documents

Processing documents involves three essential tasks for getting your document images and any unstructured data into ImageNow and integrating them with your host application. The first step is to capture the documents into ImageNow, which is typically done by scanning or importing them from a computer. Next, you review each document to ensure they were captured correctly. Once you have quality assured your documents, you link them to index keys, so they are grouped in a logical order and matched to records in your host application. After all these steps are completed, there are many features available to work with your documents, such as searching, viewing, printing, and exporting them.

ImageNow offers three methods of scanning and importing your documents. You can scan each document in on a one-by-one basis by using the Single Mode method. You can scan several documents at once using the Batch Mode method. Additionally, you can bring in logical groupings of documents using the Package Mode method. Also, each method offers customized features that let you do things like bypassing QA, sending them directly to workflow, or linking them to document index keys automatically. After you scan your documents, the next step is to review them to ensure they are correct and complete.

The method you use for quality assuring your documents matches the method you used to bring them into ImageNow. If the documents were brought in using the Single Mode, you view them in Scan Mode to quality assure them. If the documents were brought in using Batch Mode, you view them in the Batch grid to quality assure them. Lastly, if the documents were brought in using the Package Mode, you view them in Package Mode to quality assure them. Once you have finished reviewing your documents, and made any necessary corrections, you link them to specific index keys, which have been setup to work with your host application.
Linking documents is the process of matching your documents in ImageNow to specific records in your host application. Linking also gives you a way to group documents in ImageNow into a logical order by storing them in Drawers. For example, documents scanned in from different departments could be placed in corresponding drawers. Once your documents have been linked in ImageNow, you can work with them. You can view images that are linked to records in your host application by using the control bar. Or, you can search for documents in the Search grid and then view them. From there, you can export them, print them, annotate and participate in workflow as the illustration above describes. See the ImageNow Administrator Help file for related procedures and set up instructions that are not located in this User Help file.

Delete a document

1. In the Document Search window, select the document you want to delete.
2. On the Edit menu, click Delete.
3. In the confirmation dialog box, click Yes.

Batch View toolbars and menus

Batch View grid Edit menu

In Batch View, the Edit menu contains several options that enable you to edit documents shown in the Batch View grid. The options coincide with several of the icons contained in the Batch View toolbar.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes the selected document from ImageNow.</td>
</tr>
<tr>
<td>Notes</td>
<td>Opens the Document Keywords dialog box. This enables you to enter notes about the document.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all of documents in the Batch View grid.</td>
</tr>
</tbody>
</table>

Batch View toolbar and options

The toolbar in Batch View enables you to find, annotate, and manage documents.

The following options are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📜</td>
<td>File Open</td>
<td>Opens the selected document.</td>
</tr>
<tr>
<td>📑</td>
<td>Print</td>
<td>Opens the Print dialog box. This enables you to print a screen capture of the Batch View grid dialog box.</td>
</tr>
<tr>
<td>📝</td>
<td>Export</td>
<td>Opens the Export dialog box. This enables you to export the selected document to a remote location.</td>
</tr>
<tr>
<td>❌</td>
<td>Delete</td>
<td>Deletes the selected document.</td>
</tr>
<tr>
<td>📝</td>
<td>Notes</td>
<td>Opens the Document Keywords window. This enables you to enter notes about the selected document.</td>
</tr>
<tr>
<td>📁</td>
<td>Properties</td>
<td>Opens a detailed listing of information about the selected document.</td>
</tr>
</tbody>
</table>
Processing Documents

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Find</td>
<td>Opens the <strong>Quick Search</strong> dialog box. This enables you to quickly search individual columns.</td>
</tr>
<tr>
<td>![icon]</td>
<td>View</td>
<td>Sorts and displays the listed documents by their status.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Table Control</td>
<td>Opens the <strong>Table Control</strong> dialog box. This enables you to customize the Batch View grid.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Refresh</td>
<td>Re-displays document list including additions, changes, or deletions made since the last time the Batch View grid was opened.</td>
</tr>
</tbody>
</table>

### Batch View grid File menu

In Batch View, the File menu contains options that enable you to perform several application level controls. The options coincide with several of the icons contained in the Batch View toolbar.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the selected document in PowerView (Enter).</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the <strong>Export</strong> dialog box. This enables you to export the selected document to a remote location.</td>
</tr>
<tr>
<td>Find</td>
<td>Opens the <strong>Quick Search</strong> dialog box. This enables you to quickly search individual columns. (Ctrl+F).</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens a detailed listing of information about the selected document (Alt+Enter).</td>
</tr>
<tr>
<td>Page Setup</td>
<td>n/a</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the <strong>Print</strong> dialog box. This enables you to print a screen capture of the Search grid (Ctrl+P).</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Batch View grid.</td>
</tr>
</tbody>
</table>

### Batch View grid right-click menu options

The following options appear when you right-click a document in the Batch View grid:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the selected document in PowerView.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the <strong>Export</strong> dialog box. This enables you to export the selected document to a remote location.</td>
</tr>
<tr>
<td>Notes</td>
<td>Opens the <strong>Document Keywords</strong> dialog box. This enables you to enter notes about the selected document.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens a detailed listing of relevant information about the selected document.</td>
</tr>
<tr>
<td>Skip QA</td>
<td>Skips Quality Assurance process; makes the document is ready for linking.</td>
</tr>
<tr>
<td>OCR Resubmit</td>
<td>n/a</td>
</tr>
<tr>
<td>Batch Auto Process Resubmit</td>
<td>Initiates Batch Auto Process Resubmit; resubmits current task to the server.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected document from ImageNow.</td>
</tr>
</tbody>
</table>
Quality assurance

What is quality assurance?

Quality assurance (Q/A) in ImageNow is the process by which you verify that a document meets the standards of image quality that you require in order to store, view, and work with that document online. After you scan or import a single document or a batch of document objects, the first step in processing them is Q/A. The task of quality assuring a document in ImageNow means deciding which pages to keep, discard, and if needed, rescanning.

You can only Q/A a document if it has been marked in ImageNow as Scanned or Imported and the system acknowledges that it is ready for Q/A. Quality assuring documents takes place in the PowerView Batch Q/A Mode, and by default, the Batch Q/A toolbar displays in the bottom left corner of your window. Similar to all other ImageNow toolbars, you can move this Batch Q/A toolbar anywhere on the canvas and save that position.

Whether you are quality assuring one page, a document (which may contain multiple pages), or a batch of documents, you can always use the Page OK button to mark it Q/A complete. If when reviewing a batch that the first few pages meet the standards you require, you have the option to Commit Batch, which approves all pages in the batch as Q/A complete. When a page does not meet your standards of quality assurance, you can discard and rescanning, and it is not required that you discard a page before you rescanning it.

Two other options on the Batch Q/A toolbar are Suspend Batch and Stop Batch Processing. When you suspend working on documents, you can then switch to Q/A another document or batch. When you stop working on documents, you end your Q/A mode session. However, anytime you complete a Q/A process, ImageNow alerts you. Note that quality assuring documents is not required in ImageNow but it is recommended. If you choose not to Q/A your documents, then ImageNow provides you an option to bypass this step and go directly to document linking.

Open in QA mode

The QA process takes newly scanned or imported batches from the Batch View grid and opens them into PowerView QA Mode. Only documents eligible for QA are available for you to open into QA Mode. In Batch View, in order for a document to be eligible to enter PowerView QA Mode, the document must have one of the following Status, Step, and State criteria:

<table>
<thead>
<tr>
<th>Status</th>
<th>Step</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📄️</td>
<td>Scan</td>
<td>Completed</td>
<td>Successfully scanned; ready for Q/A</td>
</tr>
<tr>
<td>📤</td>
<td>Import</td>
<td>Completed</td>
<td>Successfully imported; ready for Q/A</td>
</tr>
<tr>
<td>⏳️</td>
<td>QA</td>
<td>Suspended</td>
<td>Q/A process suspended</td>
</tr>
</tbody>
</table>

1. In the Batch View window, from the Batch View toolbar, click the View icon to see which batches are ready to be quality assured.
2. Select Ready for QA.
3. Select the batch you want open into QA Mode, and then on the File menu, click Open.
Quality assure a document or batch

Whether you quality assure (Q/A) a document or batch, the Q/A process occurs in the PowerView Batch QA Mode.

1. In the Batch View grid, select the record you want to quality assure.
2. On the File menu, click Open.
3. In PowerView Q/A Mode, review the page. A page is acceptable when it meets most or all of the following standards:
   - The scanned or imported image resembles the original document.
   - No part of the page is missing due to a scanner misfeed.
   - All critical elements of the document legible (for example, signatures, account numbers, and totals).
   - The document is properly oriented and aligned.
4. In the Batch Q/A toolbar, choose one of the following options:
   - Click Page OK. If the batch was a single page document, the Batch Q/A Completed dialog box appears. If you are linking a multi-page batch, the next page of the document appears in the PowerView window, and you must click Page OK until you complete Q/A on all pages in the batch.
   - Click Commit Batch. Choose this option if you want to Q/A the batch without looking at all pages.
   - Click Discard. Discard the page if it does not meet your standard of quality, and then rescan it. Discarding a page deletes it entirely from ImageNow. You can rescan a document without discarding it first.
   - Click Rescan. Rescan a page if it does not meet your standards of quality. To rescan the page, locate the original document and either place it back into the scanner feed or reimport it from a file system.
   - Click Suspend Batch. Choose this option if you want to review another batch without ending your current session of reviewing this one.
   - Click Stop Batch Processing. Choose this option to stop document processing entirely.

Note ImageNow alerts you when quality assurance is complete.

Reimport a single document from disk

1. In PowerView Scan Mode, click the Rescan icon , and the click the Capture Profile you want to use.
2. In the Open dialog box, find the page you want to import, and then click Open to replace the document you originally imported.
3. Review the document, and then click the Scan Save icon .
Rescan a document in a batch
1. In the Batch View grid, select the batch you want to quality assure.
2. From the File menu, click Open.
3. Locate the page you want to replace.
4. On the Batch Q/A toolbar, click the Rescan icon, and then click the Capture Profile you want to use to rescan your document.
5. Insert the document you want to rescan into your scanner, and then quality assure it.

Commit entire batch as QA complete
The Commit Batch icon enables you to quality assure the entire batch without reviewing each individual page. This option is helpful if you have a large document and do not want to quality assure each page.
1. In the Batch View grid, select the batch you want to quality assure (the batch must be eligible for Q/A).
2. On the File menu, click Open.
3. The batch displays in PowerView Q/A Mode.
4. In the Batch Q/A toolbar, click the Commit Batch icon.
5. In the Batch Q/A Completed dialog box, click OK.

Note When quality assuring large documents, it is possible to spot-check certain pages.

Suspend or stop QA batch processing
Quality assuring a batch takes place in PowerView Q/A Mode. By default, the Batch Q/A toolbar displays in the bottom left corner of the PowerView window.

Suspend batch processing
The Suspending icon enables you to put the batch on hold and exits PowerView.
1. In the Batch View grid, select the batch you want to open (the batch must be eligible for Q/A).
2. On the File menu, click Open.
3. The batch will display in PowerView Q/A Mode.
4. On the Batch Q/A toolbar, click the Suspending icon. The batch will be put on hold for later processing, and PowerView will close.

Note To retrieve a suspended batch, open the batch from the Batch View grid.
Stop batch processing

The Stopping icon  enables you to stop processing, save all work, and exit PowerView.

1. In the Batch View grid, select the batch you want to open (the batch must be eligible for Q/A).
2. On the File menu, click Open.
3. The batch will display in PowerView Q/A Mode.
4. In the Batch Q/A toolbar, click the Stopping icon . A dialog box will ask you if you want to stop processing and save your work.
5. Click Yes to save the batch and close PowerView.

Linking documents

What is linking?

After completing the QA process, it is required that you link your documents, which associates them to records in your primary or host application. All linking takes place in PowerView Link Mode. When you link a document, a permanent record is created between ImageNow and your host system, and that connection remains as long as the two records exist.

Only batches eligible for linking are available to open into Link Mode. Note that the entire host application record may need to be visible for linking to be successful. Resize the PowerView window if both the windows will not fit. When working in Link mode, you can discard and relink a page, and link groups of pages. At anytime, similar to the quality assurance process, you can suspend or stop linking.

Link a document or batch

Before you can link a batch, it must be ready for linking and have the following status: which means the document is scanned and quality assured.

1. On the ImageNow Client control bar, on the Applet list, select the applet that matches your host system (the one that contains the record you want to link the document to).
2. In the Batch View grid, select the batch you want to link.
3. On the File menu, click Open, or click the Open icon .
4. In PowerView Link Mode, identify the displayed page by looking for a name, account number, or other distinguishing information.
5. Locate and open the corresponding electronic record in your host application.
6. Position the PowerView window and the corresponding host application record so they are both visible on your computer screen (you may have to adjust the size of the windows).

Note  The entire host application record may need to be visible for linking to be successful. Resize the PowerView window if both the windows will not fit (only the Batch Link toolbar needs to be visible in the PowerView window).
7. Click the Link icon in the Batch Link toolbar to create a link between the two systems (ImageNow and your host application). If the link is successful, the Batch Link Completed dialog box will display, or if you are linking a multi-page batch, the next page of the batch will display in the PowerView window. Repeat steps 3, 4, and 6 until the entire batch is linked and the Batch Link Completed dialog box appears, and then click OK.

Link using the Group and Link icon or Link Commit icon

Before using Group and Link and Link Commit, you must make sure that the Link Group Size preference has been set. Linking a batch takes place in PowerView Link Mode. By default, the Batch Link toolbar displays in the bottom left corner of the PowerView window.

Once you have linked one set of DocKeys, the Group and Link icon and Link Commit icon enable you to link several pages with the same DocKeys.

The Group Link and Link Commit options are only available if at least one of the applet's DocKey fields is set as User Entry.

1. On the ImageNow ControlBar, on the Applet list, select the applet for the host system that you want to link to.
2. In the Batch View grid, open the document you want to link (the document must be eligible for linking).
3. In PowerView Link Mode, identify the displayed page by looking for a name, account number, or other distinguishing information.
4. Locate and open the corresponding electronic record in your host application.

5. Position the PowerView window and the corresponding host application record so they are both visible on your computer screen (you may have to adjust the size of the windows).

   **Note** The entire host application record may need to be visible for linking to be successful. Resize the PowerView window if both the windows will not fit (only the Batch Link toolbar needs to be visible in the PowerView window).

6. Click the **Link** icon  📌. One or more of the DocKeys will enable (turn white) and the **Link Commit** icon 🔄 will display.

7. Enter information into the enabled DocKeys.

8. Click the **Link Commit** icon 🔄. The page is now linked with the keys you entered into the enabled DocKeys.

9. Click the **Group and Link** icon 🔄 to link the current page with the keys used to link the previous page.

10. Click the **Group and Link** icon 🔄 for each additional page you want to link with the same keys. If you want to change the DocKeys, click the **Link** icon 📌 and repeat steps 6-9.

11. Continue linking until the entire batch is linked and the **Batch Link Completed** dialog box appears, and then click **OK**.

### Put a page on hold during linking

Linking a batch takes place in PowerView Link Mode. By default, the Batch Link toolbar displays in the bottom left corner of the PowerView window. The **Hold Page** icon 🔄 enables you to put an individual page on hold for later processing.

When quality assuring large batches, it is possible to spot-check certain pages.

1. In the Batch View grid, select the batch you want to quality assure.

2. Open the batch by doing one of the following (the batch must be eligible for linking):
   - Double-click the batch.
   - On the **File** menu, click **Open**.
   - From the Batch grid toolbar, select the **Open** icon 📃.

3. The batch will display in PowerView Link Mode.

4. Using the Page toolbar, navigate to the page you want to place on hold.

5. In the Batch Link toolbar, click the **Hold Page** icon 🔄. The page will be put on hold, and the next page in the batch will display.

   **Note** To retrieve a page on hold, open the page from the Batch View grid.

### Discard a page during linking

Linking a batch takes place in PowerView Link Mode. By default, the Batch Link toolbar displays in the bottom left corner of the PowerView window. The **Discard Page** icon ✗ enables you to discard an individual page within a batch. When quality assuring large documents, it is possible to spot-check certain pages.

1. In the Batch View grid, select the batch you want to link (the batch must be eligible for linking).

2. On the **File** menu, click **Open**.

3. Using the Page toolbar, navigate to the page you want to discard.
4. On the Batch Link toolbar, click the Discard Page icon \(\text{Discard Page}\). The page will be discarded from the batch.

   **Note** If the Confirming Discarded Pages option is selected, a confirmation dialog box will prompt you to confirm the deletion. Click Yes. The page will be discarded from the batch.

**Turn on the Relink icon**

Before relinking items, you must enable the Relink icon on the toolbar. In addition, you may want to determine the Key Attributes for each DocKey.

1. On the Settings menu, point to Manage, and then click Workflow.
2. In the Available Workspace dialog box, verify that All Workspaces is selected, and then click OK.
3. In the Workflow Administrator window, double-click the queue you want to enable relinking.
4. In the Queue definition dialog box, click the Client Properties tab.
5. Select the Link Button Active option.
6. In the Applet list, select the applet you want to use, and then click OK.

**Reorganize a captured document**

1. In the Search grid, open the document that you want to reorganize.
2. In PowerView, on the View menu, click Pager.
3. On the Page Organizer toolbar, hold the CTRL key and click the pages you want to reorganize.
4. Right-click the selected pages, and then do one of the following:
   - Click Copy to New Doc.
   - Click Move to New Doc.
5. In the Copy to New Document or Move to New Document dialog box, do one of the following, and then click OK:
   - Click Relink to link the page to another record in your host application.
   - Under New Keys, manually change any of the document keys that you want.
6. In the Search grid, click Refresh.

**Using Group and Link, and Link Commit**

Before using Group and Link and Link Commit, you must make sure that the Link Group Size preference has been set. Linking a batch takes place in PowerView Link Mode. By default, the Batch Link toolbar displays in the bottom left corner of the PowerView window. Once you have linked one set of DocKeys, the Group and Link icon \(\text{Group and Link}\) and Link Commit icon \(\text{Link Commit}\) enable you to link several pages with the same DocKeys.

The Group Link and Link Commit options are only available if at least one of the applet's DocKey fields is set as User Entry.

1. On the ImageNow ControlBar, on the Applet list, select the applet for the host system that you want to link to.
2. In the Batch View grid, open the document you want to link (the document must be eligible for linking).
3. In PowerView Link Mode, identify the displayed page by looking for a name, account number, or other distinguishing information.
4. Locate and open the corresponding electronic record in your host application.

5. Position the PowerView window and the corresponding host application record so they are both visible on your computer screen (you may have to adjust the size of the windows).

   **Note** The entire host application record may need to be visible for linking to be successful. Resize the PowerView window if both the windows will not fit (only the Batch Link toolbar needs to be visible in the PowerView window).

6. Click the **Link** icon 🔄. One or more of the DocKeys will enable (turn white) and the **Link Commit** icon 🔄 will display.

7. Enter information into the enabled DocKeys.

8. Click the **Link Commit** icon 🔄. The page is now linked with the keys you entered into the enabled DocKeys.

9. Click the **Group and Link** icon 🔄 to link the current page with the keys used to link the previous page.

10. Click the **Group and Link** icon 🔄 for each additional page you want to link with the same keys. If you want to change the DocKeys, click the **Link** icon 🔄 and repeat steps 6-9.

11. Continue linking until the entire batch is linked and the **Batch Link Completed** dialog box appears, and then click **OK**.

**Suspend or stop linking a batch**

Linking a batch takes place in PowerView Link Mode. By default, the Batch Link toolbar displays in the bottom left corner of the PowerView window.

**Suspend batch processing**

The **Suspending** icon 🔄 enables you to put the batch on hold and exits PowerView.

1. In the Batch View grid, select the batch you want to open (the batch must be eligible for linking).
2. On the **File** menu, click **Open**.
3. The batch will display in PowerView Link Mode.
4. On the Batch Link toolbar, click the **Suspending** icon 🔄. The batch will be put on hold for later processing, and PowerView will close.

   **Note** To retrieve a suspended batch, open the batch from the Batch View grid.

**Stop batch processing**

The **Stopping** icon 🚫 enables you to stop processing, save all work, and exit PowerView.

1. In the Batch View grid, select the batch you want to open (the batch must be eligible for linking).
2. On the **File** menu, click **Open**.
3. The batch will display in PowerView Link Mode.
4. On the Batch Link toolbar, click the **Stopping** icon 🚫. A dialog box will ask you if you want to stop processing and save your work.
5. Click **Yes**. The batch will be saved, and PowerView will close.
E-mail

About e-mailing documents

To e-mail ImageNow documents, you must have a MAPI-compliant e-mail client installed and configured on your computer such as Microsoft Outlook. You also need to set up your e-mail in ImageNow using the ImageNow Options dialog box on the Mail tab. You can e-mail documents as links or as attachments. To e-mail a link, which must be done from ImageNow PowerView, the document must already reside in ImageNow. The recipient of an ImageNow link must have the corresponding Perceptive Software, Inc., product installed on their computer and access to the same ImageNow Server.

The sender of a WebNow link must enable WebNow for e-mailing. The recipient of a WebNow link must have access to the internal WebNow web application server. You may need to adjust your firewall settings to allow access. The recipient may also need to set up anonymous login if they do not have an ImageNow user account. You cannot view an ImageNow link in WebNow or vice versa.

Sending documents as attachments lets you send documents to users not working with ImageNow. You can e-mail an attachment from ImageNow PowerView or from the Search grid. When you e-mail an attachment from the Search grid, TIFF files within a document are automatically combined into one multi-page attachment. When you e-mail from PowerView, you can choose to combine individual TIFF files within a document into one multi-page attachment or to send each file as a separate attachment. If any of the pages of a document are not TIFF files, a separate attachment is created for each page.

E-mail a document

Choose from the following two options:

**E-mail from PowerView**

To configure ImageNow to send a WebNow link, see "E-mail a document."

1. Click the **E-mail** icon, and then select one of the following:
   - **Email - ImageNow link**
   - **Email - WebNow link**
   - **E-mail - Pages as Attachment(s)**

2. **Optional:** If you select **E-mail - WebNow link**, to remove document key information from your e-mail, open the file \[drive:]\inserver54\etc\inserverD.ini with a text editor. Under the [General] section, add the following line, and then save and close the `inserverD.ini` file:

   ```
   email.dockeys=false
   ```

3. **Optional:** If you select **E-mail - WebNow link**, open the file \[drive:]\Program Files\ImageNow\imagenow.ini with a text editor. Under the [PowerVU Settings] section, add the following line, and then save and close the `imagenow.ini` file:

   ```
   WebNowLinkAttach=1
   ```
   **Note** If the WebNowLinkAttach setting already exists, verify that the value is set to 1.
4. If you select **Pages as Attachment(s)**, do the following:
   - In the **Pages to Attach** dialog box, select the check boxes of the pages you want to send.
   - Optional: If you want to change the name of the attached file, in the **Attachment Name** box, type the name you want to give the attached file.
   - Optional: If you want to combine TIFF files into one multi-page attachment, verify that the **Create Multi Page TIFF** check box is selected.
   - Click **OK**.

5. Address and send your e-mail.

**E-mail from Search grid**

1. In the ImageNow Search grid, select the documents you want to e-mail as attachments, right-click the selected documents, and then click **Email**.

2. Address and send your e-mail.

**Set up e-mail options**

1. On the **Settings** menu, click **Options**.

2. In the **ImageNow Options** dialog box, click the **E-mail** tab.

3. Under **PowerView Send Email**, for **On mouse click**, **On ctrl-click**, and **On shift-click**, select the type of link or attachment(s) you want to configure for the mail button:
   - **E-mail - ImageNow Link**: An ImageNow Link is similar to a shortcut, or pointer file; it contains all of the information needed by ImageNow to retrieve a document and display it inside PowerView. However, as with a shortcut, the recipient of an ImageNow Link must have ImageNow installed on their PC. Additionally, they must have access to the same ImageNow server. ImageNow Links are small in size, which is ideal for e-mail. This method is great for sending document links to users within your office or workgroup. In many cases, this method can serve as an ad hoc workflow.
   - **E-mail - WebNow Link**: A WebNow Link is a URL that is sent to a user in the body of an e-mail. The user can then click on the link to access the online document hosted by the WebNow Server. This method is very useful when you need to share information to a distributed group of users. The sender of a WebNow link must enable WebNow for e-mailing. The recipient of a WebNow link must have access to the internal WebNow web application server. You may need to adjust your firewall settings to allow access. The recipient may also need to set up anonymous login if they do not have an ImageNow user account. Aside from a Netscape plugin, the user does not need to have a great deal of software loaded on their machine (no ImageNow Client). Once WebNow is accessed, the user will be required to provide a user name and password before being able to view the document.
   - **E-mail - Pages as attachment(s)**: Pages as attachment(s) is the traditional method of sending an ImageNow document as an e-mail attachment. This enables you to send documents to non-ImageNow users or users who are working out of the office environment. A downside to this method is that some document files can be quite large, and attaching them to an e-mail message can be cumbersome. Another downside is that the recipient would not be able to view (or add) any annotations to the document.
   - **No action**: The button performs no action.
4. Under **SMTP Options**, select **Send e-mail via SMTP** if you want to send e-mail using the local SMTP mail server and select from the following SMTP options, and then click **OK**.

- **Send e-mail to sender upon failure to send message**: Select this option to have an e-mail sent to the sender if their message fails to deliver.
- **Send e-mail to sender upon successful sent message**: Select this option to have an e-mail sent to the sender confirming that their message was delivered.
- **Sender's e-mail address**: Enter the e-mail address of the sender.

**Export a document**

Exporting enables you to export documents for viewing outside of ImageNow. Exporting is also helpful when you want to e-mail a document to a non-ImageNow user.

1. In PowerView, open the document you want to export.
2. In the **PowerView** window, on the **File** menu, click **Export**.
3. In the **Exporting Document to Disk File** dialog box, select a folder to export the document, and then click **OK**.

**Note**  The document will be exported in its native file format.
Search

About searching for a document

You can find a document that meets a certain criteria by searching through index keys (DocKeys), searching through Enterprise Reports Management (ERM) object index keys, or performing a full-text search through the content of all documents. To search for ERM objects or perform a full-text search, you need to install an add-on module for ERM or the ImageNow Content Server, respectively.

Using ImageNow, you can perform a simple search in the Search grid or Batch View grid. You can search for an index key that is greater than or equal to supplied text or you can search for an index key that begins with a supplied string. For example, you can search for all documents linked to Accounts Payable account number 502 or all accounts that begin with "AP". If you use an external database, like Oracle, DB2, or SQL Server, you create a more advanced search using SQL (Structured Query Language). Using SQL, you can supply multiple search conditions combined with Boolean operators.

ERM works with your host application to convert report data into ImageNow index keys and values. Using the ImageNow Server, you choose whether to capture a report as a single document or to electronically "burst" the document to individual pages that can be indexed and stored as separate documents. After your report data is imported into ImageNow, you can search for documents using multiple search conditions combined with Boolean operators.

The Content Server collects text data (gathered via OCR for scanned images) and creates searchable indexes based on the content of each document page. You can search for specific keywords using SQL queries or single word searches. The result of a content search query shows highlighted keywords in the document pages that match the search criteria. In addition, you can combine a search on an index key with a content search. For example, enter like Drawer = "HR" AND (electrical engineer) to search for matches in the HR Drawer index that contain electrical engineer in the text of the document.

Content search enables you to search the content of scanned images and more than 200 popular document formats, including Microsoft Word, Microsoft Excel, WordPerfect, and HTML. Content Server can also gather this information from PDF files created with Adobe software, including PDFWriter and Distiller. However, PDF files created in some third-party programs might not match the supported Adobe format. If you encounter issues running Content Server on PDF documents created in third-party programs other than Adobe, contact Technical Support.

Search by an index key (Simple)

1. On the ImageNow Client control bar, click Search to open the Search grid.
2. On the Simple tab, in the Find documents where list, select the index key (DocKey) you want to search.
   Note When displaying the list of index keys, ImageNow shows the captions in the currently selected applet. If no captions are defined, ImageNow displays the default DocKeys (Drawer, Folder, Tab, Field 3, Field 4, Field 5, Scan Date, and Modify Date).
3. To supply the remainder of the search criteria, do one of the following, and then click Search:
   • If you are using an embedded database, enter your search criteria.
   • If you are using an external database, select an operator, and then enter your search criteria.
4. Optional: To toggle the view of your search results from the default Search grid view to a tree list, click the Toggle button .
   Note When you close the Search grid, the last view is saved. For example, if you display the tree list and close the Search grid, the tree list appears the next time you open the Search grid.
Search using multiple index keys (Advanced)

This feature is available if you are using an external database like Oracle, DB2, or SQL Server.

1. On the ImageNow Client control bar, click **Search** to open the Search grid.

2. On the **Advanced** tab, compose the search query in the **Search for** field, and do the following:
   - Optional: Click the **Add** button to add a search condition.
   - Optional: Use the **AND** and **OR** buttons to add operators to the search query in the **Search for** field.

3. Optional: Repeat step 2 to add multiple conditions.

4. Optional: Click **Sorting**. In the **Sorting** dialog box, select a field to search by and click **Add**, to define the type of sort, in the **Sort By** column, select the same field and click **Ascending** or **Descending**, continue adding fields in this manner as needed, and then click **OK**.

5. Optional: In the Search grid, to constrain the search to a certain time period, click the **Constrain results to last <?> days** option, and then select or type the amount of time you want the search to encompass.

6. Click **Search**.

7. Optional: To toggle the view of your search results from the default Search grid view to a tree list, click the **Toggle button**.

   **Note** When you close the Search grid, the last view is saved. For example, if you display the tree list and close the Search grid, the tree list appears the next time you open the Search grid.

Add a search condition in Advanced search (SQL)

One or more search conditions can be added when searching with the Advanced search (SQL) interface. Search conditions can be saved for easy replication. In addition to regular search conditions, Prompted and LearnMode field search conditions give you additional options. Prompted search conditions enable you to enter a custom message to prompt users to enter a search value. LearnMode Field search conditions enable you to search for documents based on the DocKeys of the currently selected applet.

Add a normal search condition

1. In the Advanced search interface, click the **Add** button.

2. In the **Add Condition** dialog box, select from the following options:
   - **Condition**: This option selects how the search will be conducted. The option selected determines the available fields.
   - **Field**: This field is dynamic and depends on the option selected in the **Condition** field.

   **Note** When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.
• **Operator:** This field defines how the search is structured.

3. In the **Type** list, select **Normal**.

4. In the **Value** field, enter the value you want to search, and then click **OK**.

5. To save the query, click the **Load Query** list and select **Save Query**.

6. Click the **Search** button.

### Add a prompted search condition

Adding a Prompted search condition enables you to enter a custom message to prompt users to enter a search value.

1. In the Advanced search interface, click the **Add** button.

2. In the **Add Condition** dialog box, select from the following options:
   - **Condition:** This option selects the how the search will be conducted. The option selected determines the available fields.
   - **Field:** This field is dynamic and depends on the option selected in the **Condition** field.
     - **Note** When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.
   - **Operator:** This field defines how the search is structured.

3. In the **Type** list, select **Prompted**.

4. In the **Message** field, enter the message you want to prompt the user with when initiating a search, and then click **OK**.

5. To save the query, click the **Load Query** list and select **Save Query**.

6. Click the **Search** button.

7. In the **Condition Prompt** dialog box, which displays the custom message you entered, enter the values you want to search, and then click **OK**.

### Add a LearnMode search condition

Adding a LearnMode Field search condition enables you to search for documents based on the DocKeys of the currently selected applet.

1. In the Advanced search interface, click the **Add** button.

2. In the **Add Condition** dialog box, select from the following options:
   - **Condition:** This option selects the how the search is conducted. The option selected determines the available fields.
   - **Field:** This field is dynamic and depends on the option selected in the **Condition** field.
**Note** When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.

- **Operator:** This field defines how the search is structured.

3. In the **Type** list, select **LearnMode Field**.
4. In the **Field** field, enter the DocKey you want to search (from the currently selected applet), and then click **OK**.
5. To save the query, click the **Load Query** list and select **Save Query**.
6. Click the **Search** button. In the **Key Entry** dialog box, which displays searchable DocKeys, enter the values you want to search, and then click **OK**.

### Create and run a search query

1. Enter your search query in the **Search for** box.
2. In the **Load Query** list, select **Save Query**.
3. In the **Save Query** dialog box, select one the following options:
   - **Local:** Select this option to save the query on your local machine.
   - **Server:** Select this option to save the query on the server.
4. In the **Name** box, enter the name for the query, and then click **OK**.
5. In the **Load Query** list, select the query you want to run.
Modify or remove a query

1. In the Load Query list, select Edit Query.
2. In the Edit Query List dialog box, click the query you want to modify, and then do one or more of the following:
   - Click Rename.
   - Click the Default Query list, and then select the query you want to make the default.
   - Click Remove, and then confirm your deletion.
3. Click Close.

Explore documents by index key

Unlike the Simple and Advanced tabs, which filter data, the Explore tab enables you to view all document objects linked to an index key. This tab resembles and behaves like Windows Explorer.

1. In the Search grid, on the Explore tab, in the Load Query box, select the index key by which you want to explore.
2. In the tree list, click the plus sign (+) or the minus sign (-) to show or hide the results for that index key.

ImageNow search conditions and operators

Simple search (SQL)

Search conditions for Simple search (SQL)

<table>
<thead>
<tr>
<th>Option</th>
<th>Type of Comparison</th>
</tr>
</thead>
<tbody>
<tr>
<td>equals</td>
<td>Equal the value entered in the Search field.</td>
</tr>
<tr>
<td>start with</td>
<td>Start with the value entered in the Search field.</td>
</tr>
<tr>
<td>ends with</td>
<td>End with the value entered in the Search field.</td>
</tr>
<tr>
<td>contains</td>
<td>Contain the value entered in the Search field.</td>
</tr>
<tr>
<td>GT (&gt;</td>
<td>Exceed the value entered in the Search field.</td>
</tr>
<tr>
<td>LT (&lt;</td>
<td>Are lower than the value entered in the Search field.</td>
</tr>
<tr>
<td>GTE (&gt;=)</td>
<td>Exceed or are equal to the value entered in the Search field.</td>
</tr>
<tr>
<td>LTE (&lt;=)</td>
<td>Are lower than or equal to the value entered in the Search field.</td>
</tr>
<tr>
<td>NE (&lt;&gt;</td>
<td>Not equal to the value entered in the Search field.</td>
</tr>
</tbody>
</table>
### Advanced search (SQL)

#### Search conditions for Advanced search (SQL)

<table>
<thead>
<tr>
<th>Search condition</th>
<th>Corresponding fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>By DocKey Fields</td>
<td>Drawer, Folder, Tab, Field 3, Field 4, Field 5, ANY DocKeys, and ALL DocKeys</td>
</tr>
<tr>
<td>By User/Time</td>
<td>Creation User, Creation Time, Modification User, Modification Time, Last View User, Last View Time, and Workflow User</td>
</tr>
<tr>
<td>By Workflow Fields</td>
<td>Current Workflow Queue, Item State, Item ID, and Workflow User</td>
</tr>
<tr>
<td>By Miscellaneous Fields</td>
<td>Total Pages, Doc ID 0, Doc ID 1, Document Type, and Free Field</td>
</tr>
<tr>
<td>By All Fields</td>
<td>Select the field you want to search. (See individual options above)</td>
</tr>
</tbody>
</table>

#### Operators for Advanced search (SQL)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal to (=)</td>
<td>Selects documents whose DocKey values are equal to the entered value.</td>
</tr>
<tr>
<td>Greater than (&gt;)</td>
<td>Selects documents whose DocKey values are greater than the entered value.</td>
</tr>
<tr>
<td>Less than (&lt;)</td>
<td>Selects documents whose DocKey values are less than the entered value.</td>
</tr>
<tr>
<td>Greater than or equal to (&gt;=)</td>
<td>Selects documents whose DocKey values are greater than or equal to the entered value.</td>
</tr>
<tr>
<td>Less than or equal to (&lt;=)</td>
<td>Selects documents whose DocKey values are less than or equal to the entered value.</td>
</tr>
<tr>
<td>Not equal to (&lt;&gt;)</td>
<td>Selects documents whose DocKey values are not equal to the entered value.</td>
</tr>
<tr>
<td>Start with</td>
<td>Selects documents whose DocKey values start with the entered value.</td>
</tr>
<tr>
<td>Ends with</td>
<td>Selects documents whose DocKey values end with the entered value.</td>
</tr>
<tr>
<td>Contains</td>
<td>Selects documents whose DocKey values contain the entered value.</td>
</tr>
<tr>
<td>IN</td>
<td>Selects documents whose DocKey values match a list of values.</td>
</tr>
<tr>
<td>BETWEEN</td>
<td>Selects documents whose DocKey values are between two specified values.</td>
</tr>
<tr>
<td>LIKE</td>
<td>Selects documents whose DocKey values are similar to the entered value.</td>
</tr>
<tr>
<td>IS NULL</td>
<td>Selects documents whose DocKey values equal a null value.</td>
</tr>
<tr>
<td>NOT IN</td>
<td>Selects documents whose DocKey values do not match a list of values.</td>
</tr>
<tr>
<td>NOT BETWEEN</td>
<td>Selects documents whose DocKey values are not between two specified values.</td>
</tr>
<tr>
<td>NOT LIKE</td>
<td>Selects documents whose DocKey values are not like the entered value.</td>
</tr>
<tr>
<td>IS NOT NULL</td>
<td>Selects documents whose DocKey values not equal to a null value.</td>
</tr>
</tbody>
</table>
## Content search

### Operators for Full Text Content search

<table>
<thead>
<tr>
<th>Operator (Concept)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCRUE</td>
<td>Selects documents that include at least one of the search elements you specify. The more search elements that are present, the higher the score will be.</td>
</tr>
<tr>
<td>ALL</td>
<td>Selects documents that contain all of the search elements you specify. A score of 1.00 is assigned to each retrieved document. &lt;ALL&gt; and &lt;AND&gt; are similar and they retrieve the same results. Queries using &lt;ALL&gt; are not relevance-ranked; all retrieval results are assigned a score of 1.00.</td>
</tr>
<tr>
<td>AND</td>
<td>Selects documents that contain all of the search elements you specify. A score is calculated for each retrieved document. &lt;AND&gt; and &lt;ALL&gt; are similar and they retrieve the same results. Queries using &lt;AND&gt; are relevance-ranked; retrieved documents are assigned a score between 0 and 1.00.</td>
</tr>
<tr>
<td>ANY</td>
<td>Selects documents that contain at least one of the search elements you specify. A score of 1.00 is assigned to each retrieved document. &lt;ANY&gt; and &lt;OR&gt; are similar and they retrieve the same results. Queries using &lt;ANY&gt; are not relevance-ranked; all retrieval results are assigned a score of 1.00.</td>
</tr>
<tr>
<td>OR</td>
<td>Selects documents that contain at least one of the search elements you specify. A score is calculated for each retrieved document. &lt;OR&gt; and &lt;ANY&gt; are similar and they retrieve the same results. Queries using &lt;OR&gt; are relevance-ranked; retrieval documents are assigned a score between 0 and 1.00.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operator (Proximity)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEAR</td>
<td>Selects documents containing specified search terms. The closer the search terms are within a document, the higher the document's score.</td>
</tr>
<tr>
<td>PARAGRAPH</td>
<td>Selects documents that include all of the search elements you specify within the same paragraph.</td>
</tr>
<tr>
<td>PHRASE</td>
<td>Selects documents that include the phrase you specify. A phrase is a grouping of two or more words that occur in a specific order.</td>
</tr>
<tr>
<td>SENTENCE</td>
<td>Selects documents that include all of the words you specify within the same sentence.</td>
</tr>
</tbody>
</table>

### Operators for Natural Language Content search

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREETEXT</td>
<td>Natural language operator. Interprets text using the free text query parser, and scores documents using the resulting query expression. All retrieved documents are relevance-ranked.</td>
</tr>
<tr>
<td>LIKE</td>
<td>Searches for other documents that are like the sample one or more documents or text passages you provide. The search engine analyzes the provided text to find the most important terms to use for the search. Retrieved documents are relevance-ranked.</td>
</tr>
</tbody>
</table>
Evidence operators for Content search

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOUNDEX</td>
<td>Expands the search to include the word you enter and one or more words that &quot;sound like,&quot; or whose letter pattern is similar to, the word specified. Collections do not have sound-alike indexes by default; you must build the sound-alike indexes to use this feature.</td>
</tr>
<tr>
<td>STEM</td>
<td>Expands the search to include the word you enter and its variations.</td>
</tr>
<tr>
<td>THESAURUS</td>
<td>Expands the search to include the word you enter and its synonyms.</td>
</tr>
<tr>
<td>TYPO</td>
<td>Expands the search to include the word you enter and words similar to the query term. This operator performs &quot;approximate pattern matching&quot; to identify similar words.</td>
</tr>
<tr>
<td>WILDCARD</td>
<td>Matches wildcard characters in search strings. Certain characters automatically indicate a wildcard specification.</td>
</tr>
<tr>
<td>WORD</td>
<td>Performs a basic word search and selects documents that include one or more instances of the specific word you enter.</td>
</tr>
</tbody>
</table>

Index key operators for Content search

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal to (=)</td>
<td>Selects documents whose document field values are exactly the same as the search string you specify.</td>
</tr>
<tr>
<td>Not equal to (!=)</td>
<td>Selects documents whose document field values do not match the search string you specify.</td>
</tr>
<tr>
<td>Greater than (&gt;)</td>
<td>Selects documents whose document field values are greater than the search string you specify.</td>
</tr>
<tr>
<td>Less than (&lt;)</td>
<td>Selects documents whose document field values are less than the search string you specify.</td>
</tr>
<tr>
<td>Greater than or equal to (&gt;=)</td>
<td>Selects documents whose document field values are greater than or equal to the search string you specify.</td>
</tr>
<tr>
<td>Less than or equal to (&lt;=)</td>
<td>Selects documents whose document field values are less than or equal to the search string you specify.</td>
</tr>
<tr>
<td>CONTAINS</td>
<td>Selects documents by matching the character string you specify with the values stored in a specific document field. You can use a question mark (?) to represent individual variable characters or an asterisk (*) to match multiple variable characters of a word. These kind of wildcard searches are useful when you know only a few characters or a characteristic of a string. Question marks and asterisks cannot be used to represent white space that appears between words.</td>
</tr>
<tr>
<td>MATCHES</td>
<td>Selects documents by matching the character string you specify with values stored in a specific document field. Documents are selected only if the search elements specified match the field value exactly. When a partial match is found, the document is not selected.</td>
</tr>
<tr>
<td>STARTS</td>
<td>Selects documents by matching the character string you specify with the starting characters of the values stored in a specific document field.</td>
</tr>
</tbody>
</table>
## Operator | Description
---|---
ENDS | Selects documents by matching the character string you specify with the ending characters of the values stored in a specific document field.
SUBSTRING | Selects documents by matching the character string you specify with a portion of the strings of the values stored in a specific document field.

### ERM search
#### Search conditions for ERM search

<table>
<thead>
<tr>
<th>Search condition</th>
<th>Corresponding fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>By DocKey Fields</td>
<td>Drawer, Folder, Tab, Field 3, Field 4, Field 5, ANY DocKeys, and ALL DocKeys</td>
</tr>
<tr>
<td>By Item Fields</td>
<td>Item Value1, Item Value2, Item Value3, Item Value4, Item Value5, ANY Item Value, and ALL Item Values</td>
</tr>
<tr>
<td>By Miscellaneous Fields</td>
<td>Report Time, Creation Time, Page Count, Notes, COLD ID 1, and COLD ID 2</td>
</tr>
<tr>
<td>By All Fields</td>
<td>Select the field you want to search. (See individual options above)</td>
</tr>
</tbody>
</table>

### Operators for ERM search

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal to (=)</td>
<td>Selects documents whose DocKey values are equal to the entered value.</td>
</tr>
<tr>
<td>Greater than (&gt;</td>
<td>Selects documents whose DocKey values are greater than the entered value.</td>
</tr>
<tr>
<td>Less than (&lt;)</td>
<td>Selects documents whose DocKey values are less than the entered value.</td>
</tr>
<tr>
<td>Greater than or equal to (&gt;=)</td>
<td>Selects documents whose DocKey values are greater than or equal to the entered value.</td>
</tr>
<tr>
<td>Less than or equal to (&lt;=)</td>
<td>Selects documents whose DocKey values are less than or equal to the entered value.</td>
</tr>
<tr>
<td>Not equal to (&lt;&gt;</td>
<td>Selects documents whose DocKey values are not equal to the entered value.</td>
</tr>
<tr>
<td>Start with</td>
<td>Selects documents whose DocKey values start with the entered value.</td>
</tr>
<tr>
<td>Ends with</td>
<td>Selects documents whose DocKey values end with the entered value.</td>
</tr>
<tr>
<td>Contains</td>
<td>Selects documents whose DocKey values contain the entered value.</td>
</tr>
<tr>
<td>IN</td>
<td>Selects documents whose DocKey values match a list of values.</td>
</tr>
<tr>
<td>BETWEEN</td>
<td>Selects documents whose DocKey values are between two specified values.</td>
</tr>
<tr>
<td>LIKE</td>
<td>Selects documents whose DocKey values are similar to the entered value.</td>
</tr>
<tr>
<td>IS NULL</td>
<td>Selects documents whose DocKey values equal a null value.</td>
</tr>
<tr>
<td>NOT IN</td>
<td>Selects documents whose DocKey values do not match a list of values.</td>
</tr>
<tr>
<td>NOT BETWEEN</td>
<td>Selects documents whose DocKey values are not between two specified values.</td>
</tr>
</tbody>
</table>
### Operator Description

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT LIKE</td>
<td>Selects documents whose DocKey values are not like the entered value.</td>
</tr>
<tr>
<td>IS NOT NULL</td>
<td>Selects documents whose DocKey values not equal to a null value.</td>
</tr>
</tbody>
</table>

### Sort search results

- Sort the result grid by clicking a column header.

### Lock grid data

When you use the ImageNow embedded database, you can lock the currently displayed set of documents to perform local sorts and searches. By default, the Search grid displays 50 documents at a time. Locking temporarily disables the Page Up or Page Down icons from loading a new set of documents.

1. On the ImageNow Client control bar, click Search to open the Search grid.
2. In the Search grid, locate the set of documents you want to lock.

### Customize search

#### Set the number of documents to retrieve

**Important** The Page Up and Page Down icons are only available if you are using the embedded, default database that accompanies your ImageNow product.

You can specify the number of documents to display as a set during a search request. While the default number of documents to display as a set is 50, you can set this number between 0 and 60. After the first set of documents is retrieved when a user performs a search, the user can retrieve subsequent sets of documents by clicking the Page Down icon.
1. On the **Settings** menu, click **Options**.
2. In the **ImageNow Options** dialog box, on the **Search** tab, under **General**, in the **Maximum documents to retrieve on search request** field, enter the number of documents to retrieve as a set, and then in the **Maximum documents to prefetch back on search request** field, enter the number of documents to retrieve at a time.

### Change the Search grid display

You can customize the Search grid settings and the ERM Server subitem grid settings to fit your needs.

**Important** This procedure is for advanced end-users only.

1. Navigate to the ImageNow directory and open the **SearchGrid.ini** file.
2. Scroll down to the [Grid Display] section and use the following table to customize the Search grid settings:

<table>
<thead>
<tr>
<th>Parameter &amp; Default Value</th>
<th>Sample Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HorzLines</strong>=0</td>
<td>0 or 1</td>
<td>Adds horizontal lines to the Search grid. 0 = False, 1 = True.</td>
</tr>
<tr>
<td><strong>VertLines</strong>=1</td>
<td>0 or 1</td>
<td>Adds the vertical lines to the Search grid. 0 = False, 1 = True.</td>
</tr>
<tr>
<td><strong>FontSize</strong>=8</td>
<td>8</td>
<td>Defines the font size of the results (in points).</td>
</tr>
<tr>
<td><strong>BackColor</strong>=white</td>
<td>white, red, blue, green, black, yellow</td>
<td>Defines the Search grid background color. Several color names or RGB values may be used.</td>
</tr>
<tr>
<td><strong>SelectionColor</strong>=RGB(249,149,51)</td>
<td>RGB(249,149,51)</td>
<td>Defines the results selection color.</td>
</tr>
<tr>
<td><strong>TextColor</strong>=black</td>
<td>white, red, blue, green, black, yellow</td>
<td>Defines the Search grid text color. Several color names or RGB values may be used.</td>
</tr>
<tr>
<td><strong>StatusColWidth</strong>=45</td>
<td>45</td>
<td>Defines the width of the Status column (in pixels).</td>
</tr>
<tr>
<td><strong>Font</strong>=Tahoma</td>
<td>Tahoma</td>
<td>Defines the font of the results and column headers. You can use any font installed on your computer.</td>
</tr>
<tr>
<td><strong>FontBold</strong>=0</td>
<td>0 or 1</td>
<td>Sets the font to bold. 0 = False, 1 = True.</td>
</tr>
<tr>
<td><strong>HeaderFontSize</strong>=8</td>
<td>8</td>
<td>Defines the font size of the column header (in pixels).</td>
</tr>
<tr>
<td><strong>HeaderRowHeight</strong>=0</td>
<td>0</td>
<td>Defines the row height of the column header (in pixels).</td>
</tr>
<tr>
<td><strong>RowHeight</strong>=30</td>
<td>30</td>
<td>Defines the row height of the results (in pixels).</td>
</tr>
</tbody>
</table>
3. Optional: To change the ERM Server subitem grid settings, scroll down to the [Subitem Grid Display] section, and then customize the same settings as shown in the preceding table.

4. Save and close SearchGrid.ini file.

5. Close and reopen the Search grid to see the changes.

Return to your last position in search
1. On the Settings menu, click Options.
2. In the ImageNow Options dialog box, on the Search tab, under the General section, select the Remember search position on search close option, and then click OK.

Modify search column headers
1. On the Settings menu, click Options.
2. In the ImageNow Options dialog box, on the Search tab, under the Search Grid section, click Column Headers.
3. In the Column Headings dialog box, do one of the following, and then click OK.
   - To add a column header, click the Add row button, under the Item section, customize the column header, and then click Update row.
   - To modify a column header, select the column header row you want to edit, under the Item section, customize the column header, and then click Update row.
   - To delete a column header, select the column header you want to delete, click Delete row, and then click Yes to confirm the deletion.
4. To view the changes if the Search grid is open, close the grid and then reopen it.

Select a new column header
1. On the Settings menu, click Options.
2. In the ImageNow Options dialog box, on the Search tab, under the Search Grid section, select the Column Headers list, and select the customized column headers you want to use, and then click OK.
   Note If there are no customized column headings to choose from, you must create them. See "Modify search column headers" for more information.
3. To view the changes if the Search grid is open, close the grid and then reopen it.

Create column headers from an applet
1. On the Settings menu, click Options.
2. On the ImageNow Options dialog box, in the Search tab, under the Search Grid section, select the Create column headings from applet option, and then click OK.
3. To view the changes if the Search grid is open, close the grid and then reopen it.

Customize a column header on the Search grid
1. On the Settings menu, click Options.
2. In the ImageNow Options dialog box, click the Search tab.
3. In the Search Grid section, choose one of the following options.
   - Select the Create column headers from applet option. This will set the applet default settings as the column headers on the Search grid.
• Click the **Column Headers** button, and then in the **Column Headings** dialog box, add, edit, or delete the column headers.

• Click the **Column Headers** list, and select the customized column headers you want to use. If there are no customized column headers, you will need to create them.

4. Click **OK** to return to the **Search** tab.

**Note**  If the Search grid is open, you must close the grid and then reopen it for the changes to take effect.

### ImageNow ERM and Content Server

#### Add a search condition in ERM search

One or more search conditions can be added when searching with the ERM search interface. Search conditions can be saved for easy replication. In addition to regular search conditions, Prompted and LearnMode field search conditions give you additional options. Prompted search conditions enable you to enter a custom message to prompt users to enter a search value. LearnMode Field search condition enables you to search for documents based on the DocKeys of the currently selected applet.

![Search Interface](image)

**Add a normal search condition**

1. In the ERM search interface, click the **Add** button. In the **Add Condition** dialog box, select from the following options:

   • **Condition**: This option selects the how the search is conducted. The option selected determines the available fields.

   • **Field**: This field is dynamic and depends on the option selected in the **Condition** field.

     **Note**  When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.

   • **Operator**: This field defines how the search is structured.

2. In the **Type** list, select **Normal**.

3. In the **Value** field, enter the value you want to search, and then click **OK**.

4. To save the query, click the **Load Query** list and select **Save Query**.

5. Click the **Search** button.

**Add a prompted search condition**

Adding a Prompted search condition enables you to enter a custom message to prompt users to enter a search value.
1. In the ERM search interface, click the Add button. In the Add Condition dialog box, select from the following options:
   - **Condition**: This option selects how the search is conducted. The option selected determines the available fields.
   - **Field**: This field is dynamic and depends on the option selected in the Condition field.
     - **Note**: When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.
   - **Operator**: This field defines how the search is structured.

2. In the Type list, select Prompted.
3. In the Message field, type the message you want to prompt the user when initiating a search.
4. Click OK.
5. To save the query, click the Load Query list and select Save Query.
6. Click the Search button.
7. In the Condition Prompt dialog box, which displays the custom message you entered, type the values you want to search, and then click OK.

### Add a LearnMode search condition

Adding a LearnMode Field search condition enables you to search for documents based on the DocKeys of the currently selected applet.

1. In the ERM search interface, click the Add button. In the Add Condition dialog box, select from the following options:
   - **Condition**: This option selects how the search is conducted. The option selected determines the available fields.
   - **Field**: This field is dynamic and depends on the option selected in the Condition field.
     - **Note**: When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.
   - **Operator**: This field defines how the search is structured.

2. In the Type list, select LearnMode Field.
3. In the Field field, enter the DocKey you want to search (from the currently selected applet).
4. Click OK.
5. To save the query, click the Load Query list and select Save Query.
6. Click the Search button. In the Key Entry dialog box, which displays searchable DocKeys, enter the values you want to search, and then click OK.

### Add a search condition in Content search

One or more search conditions can be added when searching with the Content search interface. Search conditions can be saved for easy replication. In addition to regular search conditions, Prompted and LearnMode field search conditions give you additional options. Prompted search conditions enable you to enter a custom message to prompt users to enter a search value. LearnMode Field search condition enables you to search for documents based on the DocKeys of the currently selected applet.
Add a normal search condition

1. In the Content search interface, click the Add button.
2. In the Add Condition dialog box, click the Body Text tab.
3. In the Type list, select one of the following search options:
   
   **Full Text** - enables you to search content for individual words.
   
   - **Values**: Enter the values you want to search.
   - **Add Quotes**: Select this option to have quotations added to the enter values (displayed in the Search for field).
   - **Operator**: Select the operator you want to use to define your query. The Operator field defines how the search is structured. Both Concept and Proximity Operators are available. Concept operators combine the meaning of search elements to identify a concept in a document. Documents retrieved using concept operators are relevance ranked. Proximity operators specify the relative location of specific words in the document; that is, specified words must be in the same phrase, paragraph, or sentence for a document to be retrieved.
   - **Evidence**: Select the evidence you want to use to define your query. Evidence operators can specify either a basic word search or an intelligent word search. A basic word search finds documents that contain only the word or words specified in the query. An intelligent word search expands the query terms to create an expanded word list so that the search returns documents that contain variations of the query terms.
   - **Modifiers**: Select the modifiers you want to use to define your query. Options include Exclude matching values (NOT), Consider document density in scoring (MANY), Match case of entire word or phrase (CASE), and Match values in specified order (ORDER).

   **Natural Language** - enables you to specify search criteria using natural language syntax.
   
   - **Values**: Enter the values you want to search.
   - **Operator**: Select the operator you want to use to define your query. The Operator field defines how the search is structured. The natural language operators (FREETEXT and LIKE) enable you to specify search criteria using natural language syntax. The search engine uses natural language analysis to translate the query text into ImageNow Full Text query language expression for evaluating and scoring documents.

4. Click the Index Keys tab.
5. In the Index Keys tab, select from the following options:
   
   - **Field**: Select the individual field you want to search.
     
     **Note** When displaying the list of DocKeys, ImageNow will always show the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 3, Field 4, Field 5) will be replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow will display the default captions.
   - **Operator**: Select the operator to define your query.

6. In the Type list, select **Normal**.
7. In the Value field, enter the value you want to search.
8. Add Quotes: Select this option to have quotations added to the query in the Search for field, and then click Add.
9. To save the query, in the Load Query list, select Save Query.
10. The search condition will display in the Search for field.
11. Click the Search button.

Add a prompted search condition

Adding a Prompted search condition enables you to enter a custom message to prompt users to enter a search value.

1. In the Content search interface, click the Add button.
2. In the Add Condition dialog box, click the Body Text tab.
3. In the Type list, select one of the following search options:

   **Full Text** enables you to search content for individual words.
   - **Values:** Enter the values you want to search.
   - **Add Quotes:** Select this option to have quotations added to the enter values (displayed in the Search for field).
   - **Operator:** Select the operator you want to use to define your query. The Operator field defines how the search is structured. Both Concept and Proximity Operators are available. Concept operators combine the meaning of search elements to identify a concept in a document. Documents retrieved using concept operators are relevance ranked. Proximity operators specify the relative location of specific words in the document; that is, specified words must be in the same phrase, paragraph, or sentence for a document to be retrieved.
   - **Evidence:** Select the evidence you want to use to define your query. Evidence operators can specify either a basic word search or an intelligent word search. A basic word search finds documents that contain only the word or words specified in the query. An intelligent word search expands the query terms to create an expanded word list so that the search returns documents that contain variations of the query terms.
   - **Modifiers:** Select the modifiers you want to use to define your query. Options include Exclude matching values (NOT), Consider document density in scoring (MANY), Match case of entire word or phrase (CASE), and Match values in specified order (ORDER).

   **Natural Language** enables you to specify search criteria using natural language syntax.
   - **Values:** Enter the values you want to search.
   - **Operator:** Select the operator you want to use to define your query. The Operator field defines how the search is structured. The natural language operators (FREETEXT and LIKE) enable you to specify search criteria using natural language syntax. The search engine uses natural language analysis to translate the query text into ImageNow Full Text query language expression for evaluating and scoring documents.

4. Click the Index Keys tab.
5. In the Index Keys tab, select from the following options:
   - **Field:** Select the individual field you want to search.
   - **Operator:** Select the operator to define your query.
   - **Add Quotes:** Select this option to have quotations added to the query in the Search for field.
6. In the Type box, select Prompted. The next field will be automatically labeled as Message.
7. In the **Message** field, enter the message you want to prompt the user with when initiating a search, and then click **Add**.

8. To save the query, in the **Load Query** list, select **Save Query**.

9. Click **OK**. The search condition will display in the **Search for** field.

10. Click the **Search** button.

11. In the **Condition Prompt** dialog box, which will display the custom message you entered, type the values you want to search, and then click **OK**.

**Add a LearnMode search condition**

Adding a LearnMode Field search condition enables you to search for documents based on the DocKeys of the currently selected applet.

1. In the Content search interface, click the **Add** button.

2. In the **Add Condition** dialog box, click the **Body Text** tab.

3. In the **Type** list, select one of the following search options:

   **Full Text** - enables you to search content for individual words.
   
   - **Values**: Enter the values you want to search.
   - **Add Quotes**: Select this option to have quotations added to the enter values (displayed in the **Search for** field).
   - **Operator**: Select the operator you want to use to define your query. The Operator field defines how the search is structured. Both Concept and Proximity Operators are available. Concept operators combine the meaning of search elements to identify a concept in a document. Documents retrieved using concept operators are relevance ranked. Proximity operators specify the relative location of specific words in the document; that is, specified words must be in the same phrase, paragraph, or sentence for a document to be retrieved.
   - **Evidence**: Select the evidence you want to use to define your query. Evidence operators can specify either a basic word search or an intelligent word search. A basic word search finds documents that contain only the word or words specified in the query. An intelligent word search expands the query terms to create an expanded word list so that the search returns documents that contain variations of the query terms.
   - **Modifiers**: Select the modifiers you want to use to define your query. Options include Exclude matching values (NOT), Consider document density in scoring (MANY), Match case of entire word or phrase (CASE), and Match values in specified order (ORDER).

   **Natural Language** - enables you to specify search criteria using natural language syntax.
   
   - **Values**: Enter the values you want to search.
   - **Operator**: Select the operator you want to use to define your query. The Operator field defines how the search is structured. The natural language operators (FREETEXT and LIKE) enable you to specify search criteria using natural language syntax. The search engine uses natural language analysis to translate the query text into ImageNow Full Text query language expression for evaluating and scoring documents.

4. Click the **Index Keys** tab.

5. In the **Index Keys** tab, select from the following options:

   - **Field**: Select the individual field you want to search.
   - **Operator**: Select the operator to define your query.
   - **Add Quotes**: Select this option to have quotations added to the query in the **Search for** field.
6. In the Type list, select LearnMode Field. The next field will be automatically labeled as Field.
7. In the Field field, enter the DocKey you want to search (from the currently selected applet), and then click Add.
8. To save the query, in the Load Query list, select Save Query.
9. Click the Search button. In the Key Entry dialog box, which will display searchable DocKeys, enter the values you want to search, and then click OK.

Search ImageNow ERM
This feature is available if you have ImageNow ERM Server and are using an external database like Oracle, DB2, or SQL Server.

1. On the ImageNow Client control bar, click Search to open the Search grid.
2. On the ERM tab, compose the search query in the Search field, and do the following:
   - Optional: Click the Add button to add a search condition.
   - Optional: Use the AND and OR buttons to add operators to the search query in the Search field.
3. Optional: Repeat step 2 to add multiple conditions.
4. Optional: Click Sorting. In the Sorting dialog box, select a field to search by and click Add, to define the type of sort, in the Sort By column, select the same field and click Ascending or Descending, continue adding fields in this manner as needed, and then click OK.
5. Optional: In the Search grid, to constrain the search to a certain time period, click the Constrain results to last <?> days option, and then select or type the amount of time you want the search to encompass.
6. Click Search.

Search the text of documents (Content)
This feature is available if you have ImageNow Content Management Server.

Compose a Content search query
1. On the ImageNow Client control bar, click Search to open the Search grid.
2. On the Content tab, in the Search for field, type your search query.
3. To add a search condition, click Add. Otherwise, skip to step 10.
4. In the Add Condition dialog box, on the Body Text tab, from the Type list, click one of the following search options:
   - **Full Text** to search content for individual words.
   - **Natural Language** to specify search criteria using natural language syntax.

5. Select the Add Quotes check box to have quotations added to the query in the Search for field.

6. Click the Index Keys tab, and then select from the following options:
   - **Field** to select the individual field you want to search.
     
     **Note** When displaying the list of DocKeys, ImageNow always shows the captions used in the currently selected applet. The default DocKey captions (Drawer, Folder, Tab, Field 4, Field 5) are replaced with the DocKey captions defined in the selected applet. If no captions are defined, ImageNow displays the default captions.
   - **Operator** to select the operator to define your query.
   - **Type** to select how your search is conducted. Selecting Prompted search enables you to enter a custom message to prompt users to enter a search value.
   - **<Value, Field, Message>** to select or enter the value for which you want to search. This field is dynamic and depends on the option selected in the Type and Operator fields.

7. Click **OK**.

8. Use the **AND** and **OR** buttons to add operators to the search query, and repeat step 3 to add another condition.

9. To constrain the search to a certain time period, select the **Constrain results to last <?> days** check box, and then select the number of days you would like the search to encompass.

10. Click **Search**.

**Sort Content search results**

Search grid can be searched and sorted by clicking the column headers or by using the Quick Search feature. Click on the column header to sort the column. If there is a plus sign (+) to the right of the column header, this means that the data in the column is listed in ascending order. If there is a minus sign (-) to the right of the column header, the data in the column is listed in descending order.

<table>
<thead>
<tr>
<th>Modify Date +</th>
<th>Modify Date -</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/27/2003 03:20 PM</td>
<td>05/21/2003 12:54 PM</td>
</tr>
<tr>
<td>03/27/2003 03:20 PM</td>
<td>05/21/2003 12:54 PM</td>
</tr>
<tr>
<td>03/27/2003 03:20 PM</td>
<td>05/21/2003 12:54 PM</td>
</tr>
<tr>
<td>03/27/2003 03:20 PM</td>
<td>05/21/2003 12:54 PM</td>
</tr>
<tr>
<td>03/27/2003 03:20 PM</td>
<td>05/21/2003 12:54 PM</td>
</tr>
</tbody>
</table>

**View Content search results**

If you queried for a specific word or phrase, the phrase will be highlighted in the document displayed in PowerView.
Change content search highlight color

1. Using Windows Explorer, navigate to the \[drive:]\Program Files\ImageNow\ folder and edit the imagenow.ini file.
2. Scroll down to the [FullText] header.
3. Customize the HighlightColor=RGB value to the color you want.
   
   [FullText]
   
   HighlightColor=RGB(255,0,0)

4. Save and close the imagenow.ini file.
Workflow

About workflow

Workflow is the overall process of moving a document from a start point to a finish point. ImageNow workflow is able to replicate the routing and distribution of documents, such as programs, correspondence, contracts, receivables, and so forth, throughout an office environment. All ImageNow users connected to the ImageNow Server have the ability to be a part of workflow. ImageNow workflow setup can be basic – pushing documents down a linear path to completion; or the workflow can be sophisticated – involving several route paths and decision-making processes. If you have not already created the users that will be using workflow within ImageNow, you must do so before setting up your workflow process.

Workflow queue processing

Every document that is scanned or imported is placed into a workflow queue. A workflow queue is very similar to an in-basket that you might find on a work desk. On a work desk, incoming work is placed in the in-basket where it will sit until the work is finished. Completed work is placed in an out-basket where it will either be filed or sent to someone else for further processing.

ImageNow workflow uses this same concept to process document images. As documents enter workflow, they are immediately placed in a Start queue. Each item in the queue represents an individual document to be processed. The document is retrieved from the Start queue by double-clicking it in the Workflow grid. The document is opened in the PowerView viewer for processing. When you have completed processing the document, the item is sent to the Completed queue. This action is like placing the item in the out-basket. All documents in the Completed queue have been processed.

Workflow examples

In an average business environment, it is common to have certain tasks or procedures driven by the presence of a paper document. For example, when the enrollment office at a college receives a student application, a specific process is started for that student. First, a file or record of the student is created; this could be a paper file folder, an electronic database record, or both. The file then moves onto a staff member who refers to information on the document and performs a specific task. After performing the task, the file is then passed on to another staff member or another office. This process can continue for several steps before the file is put into permanent storage.

To help you better understand the workflow concept, examine the following descriptions of sample workflow environments:

**New insurance policy processing** - ImageNow workflow allows the insurer to define a route-based workflow environment in which inbound polices are first imaged. The policy images are then routed through a multi-tiered process of review where decision value is added at various states.

**Incoming facsimile processing** - In a high volume inbound fax environment, ImageNow workflow can utilize information provided by the fax environment, such as Direct Inward Dialing (DID), to automatically populate individual queues with electronic documents. These documents can be linked to host records to be further reviewed and routed as necessary.
Accounts payable invoice processing - Voucher related documents such as receiving documents, purchase documents, vendor invoices, payment slips, and other data can be imaged and routed to data entry. Data entry can create transaction records from the imaged data to automatically link it to the host record. The imaged documents can then be routed further, for example, to an approving party. Images can be viewed throughout the system the instant the documents are scanned.

Workflow grid view

Workflow is made up of several components that contribute different functions to the workflow process.

Workflow grid toolbar

The Workflow grid toolbar enables you to find, annotate, and manage documents.

The following options are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📂</td>
<td>File Open</td>
<td>Opens the selected document.</td>
</tr>
<tr>
<td>📹</td>
<td>Print</td>
<td>Opens the Print dialog box. This enables you to print the selected document.</td>
</tr>
<tr>
<td>✗</td>
<td>Delete</td>
<td>Deletes the selected document.</td>
</tr>
<tr>
<td>📄</td>
<td>Notes</td>
<td>Opens the Document Keywords window. This enables you to enter notes about</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the selected document.</td>
</tr>
<tr>
<td>📁</td>
<td>Properties</td>
<td>Opens a detailed listing of information about the selected document.</td>
</tr>
<tr>
<td>🔍</td>
<td>Find</td>
<td>Opens the Quick Search dialog box. This enables you to quickly search</td>
</tr>
<tr>
<td></td>
<td></td>
<td>individual columns.</td>
</tr>
<tr>
<td>📚</td>
<td>Table Control</td>
<td>Opens the Table Control dialog box. This enables you to customize the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Workflow grid.</td>
</tr>
<tr>
<td>✈</td>
<td>Refresh</td>
<td>Re-displays document list including additions, changes, or deletions made</td>
</tr>
<tr>
<td></td>
<td></td>
<td>since the last time the Workflow grid was opened.</td>
</tr>
</tbody>
</table>

Clicking the Queue list will display all of the work queues.
Queue list

The items displayed in the Workflow grid are items residing in the queue selected in the Queue list. If you select a different queue from the Queue list, the items contained in that queue will be listed in the Workflow grid.

Workflow grid tools

Additional options are available by right-clicking the selected document in the Workflow grid. The following menu will display:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the selected document in PowerView.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens a detailed listing of information about the selected document.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected document from workflow.</td>
</tr>
<tr>
<td>Merge</td>
<td>Merges two or more documents into one.</td>
</tr>
<tr>
<td>View in Preview Mode</td>
<td>Opens selected document in Preview Mode.</td>
</tr>
<tr>
<td>History</td>
<td>Displays the workflow history of the document.</td>
</tr>
<tr>
<td>Reset to idle</td>
<td>Resets the selected document to idle.</td>
</tr>
<tr>
<td>Route Forward</td>
<td>Enables you to forward the selected document to one of your assigned queues. (If no queues are assigned, nothing will display.)</td>
</tr>
</tbody>
</table>

Troubleshoot workflow

I accidentally deleted my workspace. How do I create a new one?

1. On the Settings menu, point to Manage, and then click Workspaces.
2. In the Resource Manager dialog box, on the Workspaces tab, click New.
3. Type a name for the new workspace, and then press ENTER.
4. Click Close.

Why can't I set a default workspace?

Setting a default workspace is not possible. Each time you click Settings, Manage, Workflow, you must select the workspace you want in the Available Workspace dialog box.

Why can't I see all of the items in the Workflow queue list?

ImageNow has the ability to limit the number of items that are sent from the server to the client. This number is "hard-coded" at 1,000 to greatly improve the performance of the workflow list.

In keeping with good workflow design and maintenance, it is a good idea not to let the number of items in a queue get too large. As with any storage system, you do not want too many items in one place. Server and client performance suffers as items pile up in a queue.
Instead, try to design your system to allow for more distributed workflow. Keep in mind, you can set up a single workflow queue for archival purposes (for example, “Terminal”) that users cannot access. As items are completed, they can be routed to the Terminal queue, where thousands and thousands of items could reside, without having a negative impact on performance.

If you are in a situation where you must have more than 1,000 items in a queue, and users must be able to view a list of all items in the queue, follow these steps:

1. Navigate to the [drive:]Program Files\ImageNow folder.
2. Open the imagenow.ini file and make the following modification, where "x" is equal to the number of items you want to display in the list.
   
   ![Workflow]
   
   ItemListMax=x
3. Save and close the file.

**Note** Perceptive Software, Inc., does not recommend that you alter this default setting. Doing so may cause abnormal and unsupported behavior on the client. If problems occur when opening a workflow list after making this change, please revert back to the default "1000" items.

**Why can't I relink a document in workflow?**

If a document key field is not set to be user modifiable, you won't be able to relink it in workflow. A field that is not set to be modifiable will be indicated with a red outline when trying to relink. A green outline indicates that the field is user modifiable.

1. On the Settings menu, point to Manage, and then click Workspaces.
2. In the Resource Manager window, click the Workspaces tab, click the workspace you want, and then click Modify.
3. In the ImageNow Workflow Administrator window, double-click the queue you want.
4. In the Queue Definition dialog box, click the Client Properties tab.
5. Under General Settings, verify that the Update Only Empty Key Values check box is not selected.
6. Under Key Attributes, on each of the relevant document key tabs, verify that the Modifiable check box is selected, and then click OK.
7. On the File menu, click Exit.
8. In the Resource Manager window, click Close.

**Set up workflow**

**Select a start queue**

Items enter workflow through a start queue. Most workflow systems only have one start queue. Think of a start queue as a mailroom; items are received, then distributed to their new destination.

1. On the Settings menu, click Start Queues, or right-click the Workflow icon.
2. Select a start queue from the menu.
Select a work queue

A work queue is like an inbox. As items get routed into your Work queue, they become available for you to view. When you are finished viewing the item, you can pass it on to another user's work queue.

1. On the Settings menu, click Work Queues, or right-click the Workflow icon.
2. Select a work queue from the menu.

Workflow status bar and alarms

The status bar at the bottom of the ImageNow Client control bar indicates the currently selected Work queue and the number of items in it. The status bar also contains a set of customizable workflow alarm mechanisms to alert users and administrators as items fill the queues.

Alarms are configured based on watermark levels and elapsed time. Once an alarm has been triggered, the customizable alarm notification will alert you.

**Note** Alarms are completely customizable. Alarms can be configured to turn on at different levels, to use different colors, and flash different blink patterns.

Using workflow

Send a document to workflow

You must have your workflow environment set up prior to being able to complete this procedure.

1. In the Search grid window, click the document you want to send to workflow.
2. On the File menu, point to Send To, and then click the workflow queue.
3. In the ImageNow dialog box, click Yes.

Set up and view recently routed items

1. In the PowerView Workflow Mode window, on the Workflow toolbar, click the Recent Routed Items icon.
2. Click Configure.
3. In the Workflow Recent Configuration dialog box, select the information you want to view for recently routed items, and then click OK.
4. When you click the Recent Routed Items icon on the Workflow toolbar, recently routed items will display.

5. Click the recently routed item you want to display in PowerView Mode.

**View documents in a workflow queue**

1. Click the Workflow icon.
2. In the Queue list, select the queue that you want.
3. Select the document that you want, and then on the File menu, click Open.
4. In the PowerView Workflow Mode window, select one of the following:
   - **Next Item** - Brings up the next object in the queue. Before the next item is retrieved, you are asked what to do with the current item. The current item can be placed on hold or returned to the queue for later processing.
   - **Choose Any Item** - Displays all items in the current queue. To view an item, select the item, and then on the File menu, click Open.
   - **Choose Hold Item** - Displays all items that you currently have on hold. To view an item, select the item, and then on the File menu, click Open.
Note  If you select a new item while you processing an existing item, you will be prompted to put the item on hold or return it to its queue.

Route items in a queue

1. Click the Workflow icon.
2. In the Queue list, select the queue that you want.
3. Select the document that you want, and then on the File menu, click Open.
4. In the PowerView Workflow Mode window, click the Route Forward icon to send the item to a subsequent queue.
5. Optional: If there is more than one possible subsequent queue, do one of the following:
   - Click the Route Forward icon to display a menu of possible destination queues. Select a destination queue by clicking on it.
If you have ImageNow 5.42 and there is more than one possible subsequent queue, clicking the **Route Forward** icon displays a **Routes** dialog box.

This dialog box is capable of displaying a greater number of possible destination queues than the menu in the first option. Click the destination queue that you want, and then click **OK**. Perform the following steps to enable this feature:

1. Open the \[drive:]\Program Files\ImageNow\imagenow.ini file.
2. Under [PowerVU Settings], set **ShowRoutesInList=1**.
3. Save and close the imagenow.ini file.

6. Optional: Click the **Route Back** icon to send the item back to the queue from which it came. The **Route Back** icon is only available if the route back option is enabled for the queue.

**Automatic routing**

In most cases, documents will be automatically routed from the one queue to the next queue:

![Diagram of automatic routing](image)

When you click the **Route Forward** icon, the document will automatically be sent to the next queue.

**Manual routing**

In special cases, workflow may be set up for manual routing. When you click the **Route Forward** icon in a queue set up for manual routing, you will need to select the next queue to which to send the document. Because it requires manual user intervention, this is known as a manual route path.

![Diagram of manual routing](image)
Process an item in workflow

Workflow must be previously configured for the following instructions to work.

1. On the Settings menu, point to Work Queues, or right-click on the Workflow icon. Select the work queue of your choice. In the Control bar status bar, the Queue list should reflect the work queue you chose.

2. Click the Workflow icon to display the items in the selected workflow queue.

3. Double-click on the desired item or select it and on the File menu, click Open. The selected item will display in PowerView Workflow Mode.

4. Perform any functions you need to do to the document (check signature, add annotation, and so forth) and then use the options in the Workflow toolbar to route the document.

Put a workflow item on hold

On occasion, you may not be able to completely process a document. For example, the information on the document may be unreadable or incorrect. In such a case, you may need to consult with the person who generated the document.

A document that is not fully processed can either be returned to the Workflow grid or placed on hold. If you return a document to the Workflow grid, another user may come across the document and have the same problems processing it; or worse, they may process it incorrectly.

When you place a document on hold, you are setting it aside so that no one else can inadvertently process it. The document will remain on hold until you get all of the information needed to complete it.

1. In the Workflow grid, open the item you want to view. The item will display in PowerView Workflow Mode.

2. On the Workflow toolbar, click the Hold icon. The item will display the held items grid.
Retrieve a workflow item on hold

1. In PowerView Workflow Mode, on the Workflow toolbar, click the **Choose Hold Item** icon.

![Held items for: administrator](image)

2. This **Held item for** window displays a list of all of the items that you have on hold. To resume processing a document, double-click it to take it off hold and open it in PowerView.

Relink a document in workflow

Linking a document originally occurs in the Batch View grid. Once a document has been linked in the Batch View grid, it is sent to the Search grid, where it can then be sent to workflow. However, if you want to change or add document keys, it is possible to do this within workflow. In Workflow Mode, the **Relink** icon is used to relink an item to a different host application record. When the appropriate record is onscreen, click the **Relink** icon to take information from the host application and link it to the item.

The **Relink** icon will only be accessible if the queue and DocKeys have been enabled for relinking.

As part of the linking process, you will link a document to a record in your host application. Linking documents takes place in PowerView Workflow Mode. Workflow Mode has its own toolbar that appears in the bottom left corner of the PowerView window.

1. In the **Applet** list on the ImageNow Client control bar, select the applet that matches your host system (the one that contains the record you want to link the document to).

2. In the Workflow grid, locate the document you want to link. Double-click the item, or select the document and on the **File** menu, click **Open**.

3. In PowerView Workflow Mode, identify the displayed page by looking for a name, account number, or other distinguishing information.

4. Locate and open the corresponding electronic record in your host application.

5. Position the PowerView window and the corresponding host application record so they are both visible on your computer screen (you may have to adjust the size of the windows).

   **Note** The entire host application record may need to be visible for linking to be successful. Resize the PowerView window if both the windows will not fit (only the Workflow toolbar needs to be visible in the PowerView window).

6. On the Workflow toolbar, click the **Relink** icon. Some DocKeys will be outlined with green or red. Green indicates that the field is user modifiable. Red indicates that the DocKeys are not user modifiable.

7. Click the **Relink** icon. The new data from your host application will be copied and pasted into the DocKeys.

8. Close PowerView. The new DocKey changes will display in the Workflow grid.
Hold, delete or cancel workflow processing

1. Click the Workflow icon.
2. In the Queue list, select the queue that you want.
3. Select the document that you want, and then on the File menu, click Open.
4. In the PowerView Workflow Mode window, select one of the following:
   - **Hold** - Places objects on hold for later processing. Items on hold can be recalled later by clicking the Chose Hold Item icon.
   - **Cancel** - Exits the workflow process. Clicking the Cancel icon closes the PowerView window and returns you to the ImageNow ControlBar.
   - **Delete** - Removes an item from a queue. Although the item is deleted from the workflow queue, it is not removed from the ImageNow Server memory; it can be found again using the Document Search grid.

Remove a document from workflow

1. In the Workflow grid, in the Queue list, select the queue containing the document you want.
2. Click the document you want to remove from workflow.
3. On the grid toolbar, click Delete.
4. In the ImageNow dialog box, click Yes.

**Note** Removing a document from workflow does not delete the document from the ImageNow database.

**Tip** To select multiple documents for removal from workflow, press the CTRL key and click each document you want to remove.
Search for a document in workflow

1. In the Workflow grid, in the Queue list, select the workflow queue you want to search.
2. On the Workflow grid toolbar, click the Find icon.
3. In the Quick Search dialog box, in the Please enter search text box, type your search query.
4. In the Search column box, select the column that you want to search, and then click OK.

Sort fields in a workflow grid

The columns that display in bold type indicate that the field can be sorted or searched. To sort a field in ascending order, click the column header once. A plus sign (+) will display on the header to indicate that the field is being sorted in ascending order.

To sort a field in descending order, click the header a second time. A minus sign (-) will display on the header to indicate that the field is being sorted in descending order.

Multi-column sorts can be used to sort more than one column of data. For instance, you may want to first sort by the Drawer column in ascending order, then sort those results in descending order in the SSN column.

1. Open the Workflow grid. Select the first column for sorting. Click on the column header once to sort in ascending order. You will see a plus sign (+) after the column name.
2. Locate the secondary sort column. Hold down the SHIFT key on your keyboard while clicking on the secondary column header. You will see either a plus (+) or minus (-) sign indicating the sort order. You will also see a "2" to indicate the secondary sort column.

3. Continue sorting by additional columns by repeating step 2. You will be able to sort by up to four columns.
4. To cancel one or more multi-column sort conditions, hold down the SHIFT key on your keyboard while you right-click on the column header that you wish to cancel.

Note When more than one column header is selected, the column headers will remain sorted until they are canceled (hold down they SHIFT key and click the right mouse button).

Preview and merge pages in workflow

Preview Mode enables you to preview and merge additional pages to a document you are viewing in Workflow Mode.

1. In the Workflow grid, open the document to which you want to merge pages. The document will display in Workflow Mode.
   
   **Note** If a document is not open in Workflow Mode, you will be unable to merge in Preview Mode.
2. In the Workflow grid, locate the document you want to merge. Right-click on the selected document in the Workflow grid.
3. Select **View in Preview Mode**. The selected page will be displayed in a separate PowerView Preview Mode window.

4. Preview the displayed page. Decide if you want to merge the page with the document being displayed in the PowerView Workflow Mode window.

   **Note** Look for information on the document that identifies the page as part of the multi-page document. For example, the account number and name should match. You should also look for the displayed page number (for example, Page 2 of 3).

5. Click the **Merge** icon to merge the page with the document.

**EOB Processing**

**About EOB processing**

EOB processing can be used anywhere that a single document needs to be linked to more than one set of DocKeys, and requires that the EOB Agent is installed.

EOB processing, or Multi-Link, is a new functionality within ImageNow that allows a user to easily assign multiple index keys to a single scanned document. The multiple key values are then used by a server process to create multiple copies of the document. Multi-Link includes a new PowerView control that displays within the EOB entry workflow queue.

EOB processing got its name because it addresses a specific business process within the health care and insurance industry. EOB, or Explanation of Benefits, documents are descriptive documents that support insurance payments to health care companies.

As part of routine business, an insurance company will cut one check to a hospital that pays for many different patients. The accompanying EOB document describes how the single payment breaks down across the many patient accounts.
The EOB must be linked to each individual patient account with an ImageNow link. The challenge was to come up with a way to avoid having to manually copy or rescan the EOB document each time for each individual patient. A single EOB can be anywhere from 1 to 200 pages, with each page containing between 1 to 20 lines. In other words, a single EOB could address well over 1,000 patient accounts.

Benefits of EOB processing

**Decrease Data Entry** - Automatically link each EOB event and its disbursement amount to individual patient records in your application software.

**Post Cash Faster** - Simultaneously view the exact EOB Event/page you need while posting cash in your billing software.

**Respond to Inquiries Quickly** - Instant, electronic visibility to EOB statements allows you to immediately respond to inquiries regarding payments and charges.

**Save Time and Paper** - Enhance productivity by printing, faxing, and e-mailing EOB pages from your desktop.

**Ensure Confidentiality** - Secure key data by using ImageNow electronic annotation features, which include redaction (masking), highlights, and sticky notes. Eliminate the need to fold, tape over, mask, or highlight data on physical documents.

**Work More Efficiently** - Build workflow processes that match the way you handle EOB processing. ImageNow graphical workflow environment can support your auditing requirements, manage all exceptions, and verify that all EOB’s are connected to patients in your application software. ImageNow workflow tracks all EOB’s it receives and keeps a complete audit trail of the actions taken upon them.

While it was initially intended and designed for this specific EOB solution, EOB processing functionality has a place in many other areas as well. Financial Aid in Higher Education has similar needs, as they receive money from several sources.

Using Multi-Link, the document can be linked with several DocKeys. Once linked, the document is copied so that each DocKey has its own individual copy of the document.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>drawer1, 342:78:1977,...</td>
<td>8.00</td>
</tr>
<tr>
<td>Default, 123:45:6789,...</td>
<td>4.00</td>
</tr>
<tr>
<td>Default, 123:45:6789,...</td>
<td>11.00</td>
</tr>
<tr>
<td>Default, 123:45:6789,...</td>
<td>19.00</td>
</tr>
</tbody>
</table>

The dollar amount assigned to each DocKey (each patient's individual total) is totaled and compared against the validation total. If the **Total** field does not equal the **Validation** field, the difference will be calculated in the **Diff** field.
Use EOB to link documents in workflow

EOB processing is only available if the EOB Agent has been installed and configured. EOB processing adds additional options when linking in Workflow Mode. It allows you to link one document with several different DocKeys. Once linked, the document is copied so that each DocKey has its own individual copy of the document.

EOB processing only works in an EOB entry queue. In the Workflow grid, select the EOB Entry queue and open one of the documents. PowerView will display Workflow Mode with an additional tab.

The Multi Keys tab enables you to link the document to several different DocKeys.

Use amount validation feature

The Amount Validation feature is used when linking several patients name to one EOB (Explanation of Benefits) document. By entering the total dollar amount in the Validation field and then entering the dollar amount for each patient, you can check to see if you entered all the numbers correctly.
Using Multi-Link, the document can be linked with several DocKeys. Once linked, the document is copied so that each DocKey has its own individual copy of the document.

Use EOB processing to link a document

1. Open your host application and make sure it is visible on the desktop. Open the host application record to which you want to link the document.
2. In the Workflow grid, select your EOB Entry queue and open the document you want to multi-link.
3. If you are using the Amount Validation feature, click the **Validation** button and enter the total amount of the Explanation of Benefits.
4. In PowerView, make sure the **Document Keys** window is displayed (If it isn't, click **View**, and then click **Document Keys**). In the **Document Keys** window, click the **Multi-Keys** tab.
5. Click the Multi-Link icon. In the EOB Link dialog box, ImageNow will automatically take the information from your host application and populate the fields in the Keys section. User Entry fields will display as modifiable and will require you to enter something in the field.

6. If you are using the Amount Validation feature, enter a dollar amount in the Amount field.

7. Click OK. The document will be linked and will display in the Document Keys window.

Note: If the wrong information appears, or if you selected the wrong host record, select the correct host record and click Relink.
Annotations

What is an annotation?

You use an annotation in ImageNow to mark up and comment on a document object without affecting the original image. You can position annotations where you need in the document. ImageNow offers many types of annotations so you can express the different points you want to make. For example, in ImageNow, you can express your review of a document by stamping it approved, signing off on it using a pen, or adding a check mark. You can also add sticky notes to add small notes to a document object, either inline or as a global comment on the document.

Annotations are customizable. You set preferences to show or hide annotations or to turn on or off annotations you may not use. You can also create your own annotations by modifying existing ones, using the Rubber Stamp Wizard, or for the more advanced user, inserting code variables, applicable to stamp creation only.

To use annotations, you must be viewing a document object, and you can add annotations in all ImageNow modes where you can view a document such as Workflow Mode, View Mode, Search Mode, and QA Mode.

Add a check annotation

In PowerView, the Check icon annotation enables you to place a checkmark on a document image.

1. In PowerView, open the document that you want to add the annotation to.
2. On the Annotation toolbar, click the Check icon. The cursor will display as a crosshair.
3. Click on the document image where you want the checkmark to be placed.
Add a highlight annotation

In PowerView, the **Highlight** icon 📈 annotation enables you to highlight a selected area of a document image.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Highlight** icon 📈. The cursor will display as a crosshair.
3. Click and hold the mouse button on the document image where you want to start highlighting.
4. While holding the mouse button, drag the mouse to select the area you want to highlight. A black square will display in the selected area.
5. Release the mouse button once you have selected the area you want to highlight.

Add a hollow mask annotation

In PowerView, the **Hollow Mask** icon 🐑 annotation enables you to block out a selected area of a document image.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Hollow Mask** icon 🐑. The cursor will display as a crosshair.
3. Click and hold the mouse button on the document image where you want to place a hollow mask.
4. While holding the mouse button, drag the mouse to select the area you want a hollow mask around. A black outline will display in the selected area.
5. Release the mouse button.

Add a redline annotation

In PowerView, the **Redline** icon ✍️ annotation enables you draw red lines on a document image.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Redline** icon ✍️. The cursor will display as a crosshair.
3. Click and hold the mouse button to begin redlining on the document image.
4. After you are finished redlining, to turn off the Redline, click the **Annotation Off** icon ⏹️, or select another annotation.
Add a solid mask annotation

In PowerView, the **Solid Mask** icon 🟢 annotation enables you to block out a selected area of a document image.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Solid Mask** icon 🟢. The cursor will display as a crosshair.
3. Click and hold the mouse button on the document image where you want a solid mask.
4. While holding the mouse button, drag the mouse to select the area you want to solid mask. A black square will display in the selected area.
5. Release the mouse button.

Add a sticky note annotation

In PowerView, the **Sticky Note** icon 📝 annotation enables you to add small notes to document images.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Sticky Note** icon 📝. The cursor will display as a crosshair.
3. Click on the document image where you want the Sticky Note to be placed.
4. In the **Sticky Note** text box, enter your message. The menus and icons are similar to those of a word processor.
5. Click the **Commit** icon 📝 to save the message. The saved message will display below the text field. The time, date, and user will be saved along with the message.

   **Note**  Saved text is non-modifiable.

6. Click the **Close** button ✖️ on the **Sticky Note** title bar.
7. To view a placed Sticky Note, double-click the placed Sticky Note on the document image.

**Edit a sticky note**

1. Double-click the placed Sticky Note on the document image.
2. Click on the document image where you want the Sticky Note to be placed.
3. In the **Sticky Note** text box, enter your message. The menus and icons are similar to those of a word processor.
4. Click the **Commit** icon to save the message. The saved message will display below the text field. The time, date, and user will be saved along with the message.

**Add a text annotation**

In PowerView, the **Text** icon annotation enables you to place text on document images.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Text** icon. The cursor will display as a crosshair.
3. Click on the document image where you want the text to be placed. A cursor will display and begin flashing.
4. Enter your text message.
5. Click the **Annotation Off** icon when you are finished, or select another annotation.

---

**Show or hide annotations**

On the Annotation toolbar, the **Toggle Show Annotations** icon enables you to hide or restore all placed annotations. Hiding annotations enables you to view the original unmarked document without deleting the placed annotations. This feature is useful when viewing documents that have been marked with several annotations.

1. In PowerView, locate the document with the annotation you want to show or hide.

2. On the **Annotation** toolbar, click the **Toggle Show Annotations** icon.

**Note** Closing the document with the annotations hidden will not delete the annotations. The annotations will display on the document the next time it is opened.

---

**Delete an annotation**

Placed PowerView annotations can be deleted individually or together. If you want to temporarily remove the annotations to view a document, you can do so without deleting them by hiding them.

---

**Delete an individual annotation**

1. In PowerView, locate the document with the annotation you want to delete.

2. On the **Annotation** toolbar, click the **Move/Resize** icon.

3. Click on the existing annotation you want to delete. The annotation will be outlined with a dotted line with large black squares.

4. Press the **Delete** key on your keyboard.

5. In the confirmation dialog box, click **Yes**.

---

**Delete all annotations**

1. In PowerView, locate the document with the annotations you want to delete.

2. On the **Annotation** menu, click **Delete All**.

3. In the confirmation dialog box, click **Yes**.
Turn off annotations

On the Annotation toolbar, the **Annotation Off** icon enables you to deselect the current annotation you are using. This feature is useful when you want to stop using an annotation and return to using the cursor. For example, the Text and Redline annotations do not turn off until you deselect them, or until you choose another annotation.

- To deselect or turn off an annotation, click the **Annotation Off** button on the **Annotation** toolbar. The annotation will be disabled, and the cursor will display.

Add an arrow annotation

In PowerView, the **Arrow** icon annotation enables you to place an arrow on a document image.

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **Arrow** icon. The cursor will display as a crosshair.
3. Click and hold the mouse button on the document image where you want the end of the arrow (the arrowhead will be at the other end).
4. While holding the mouse button, draw a line towards the area of the document to which you want the arrow to point.
5. Release the mouse button.

Attach a document to an ImageNow document

In PowerView, the **OLE Item** icon annotation utilizes the Microsoft OLE (Object Linking Embedding) technology to insert objects as annotations. This technology enables you to insert sounds, pictures, or any other object supported by your system. There are two ways to insert an OLE Item into a document: create a new object, or insert an existing object.

Insert an existing object

1. In PowerView, open the document that you want to add the annotation to.
2. On the **Annotation** toolbar, click the **OLE Item** icon. The cursor will display as a crosshair.
3. Click the mouse button on the document image where you want to insert an object.
4. In the Insert Object dialog box, select the Create from File option.
5. Use the Browse button to locate the object you want to insert.
6. Select the Display As Icon checkbox.
7. Click OK. The object will display as an icon in the document. Double-click the icon to open the object in its associated application.

Note: Selecting the Link option will create a shortcut to the file so changes made outside of ImageNow will be reflected in the document.

Create and insert an object

1. In PowerView, open the document that you want to add the annotation to.
2. On the Annotation toolbar, click the OLE Item icon. The cursor will display as a crosshair.
3. Click the mouse button on the document image where you want to insert an object.
4. In the Insert Object dialog box, select the Create New option.
5. Select the type of object you want to insert from the Object Type list.
6. Select the Display As Icon checkbox.
7. Click OK. The associated application of the object you selected will start.
8. In the associated application, create the object you want to insert.
9. When you are finished, close the associated application (you do not need to save). The object will display as an icon in the document. Double-click the icon to open the object in its associated application.

Note: You can insert an object directly on the document image without using an icon. However, the object may appear small or distorted.

Stamps

Create a text or graphic stamp

1. In PowerView, click the Stamp icon, and then click Edit Stamps.
2. In the Rubber Stamp Wizard dialog box, click Next.
3. Select Add a Stamp, and then click Next.
4. In the Add Stamp dialog box, select the type of stamp you want to add.
   - Text: Created from scratch; they can be configured for color, shape, font, content, and many other features.
   - Graphic: Created by importing external graphic files. Once imported, the graphic can be configured in size and color.

Create a text stamp

1. Enter a name for the new stamp. Select Text, and then click Next.
2. In the Text Stamp Page 1 dialog box, enter the stamp message in the text fields.
3. Click the Font button to adjust the font and font size.
4. Click the Insert Code button to insert pre-defined date, time, and user codes.
5. Click Next.
6. In the **Text Stamp Page 2** dialog box, click the **Frame** list to select a shape for the stamp.
7. Click the **Border** slider to configure the stamp border.
8. Click the **Font Color**, **Fill Color**, and **Frame Color** lists to select the stamp color.
9. Click **Finish**. The new stamp will display in the **Stamp** menu.

**Create a graphic stamp**

The Graphic Stamp only supports bitmap (.bmp) graphic files.

1. Enter a name for the new stamp. Select **Graphic**, and then click **Next**.
2. In the **Graphic Stamp** dialog box, click the **Browse** button to navigate to the graphic file.
3. Use the **Frame Type** and **Frame Color** lists to configure the stamp shape and color. Use the **Horizontal** and **Vertical** fields to configure the stamp size.
4. Click **Finish**. The new stamp will display in the **Stamp** menu.

**Code variables for a custom stamp**

The Insert Code button enables you to enter predefined dynamic codes that will represent current time, dates, and user names. For example, the default code "%%m/%%d/%y" will display the current date (month/day/year).

The following codes are available:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>%%</td>
<td>Percent sign</td>
<td>%</td>
</tr>
<tr>
<td>%a</td>
<td>Abbreviated weekday name</td>
<td>FRI</td>
</tr>
<tr>
<td>%A</td>
<td>Full weekday name</td>
<td>FRIDAY</td>
</tr>
<tr>
<td>%b</td>
<td>Abbreviated month name</td>
<td>OCT</td>
</tr>
<tr>
<td>%B</td>
<td>Full month name</td>
<td>OCTOBER</td>
</tr>
<tr>
<td>%c</td>
<td>Date and time representation appropriate for locale</td>
<td>10/18/01 10:15:45</td>
</tr>
<tr>
<td>%d</td>
<td>Day of month as decimal number (01-31)</td>
<td>18</td>
</tr>
<tr>
<td>%H</td>
<td>Hour in 24-hour format (00-23)</td>
<td>22</td>
</tr>
<tr>
<td>%I</td>
<td>Hour in 12-hour format (01-12)</td>
<td>10</td>
</tr>
<tr>
<td>%j</td>
<td>Day of year as decimal number (001-366)</td>
<td>245</td>
</tr>
<tr>
<td>%M</td>
<td>Minute as decimal number (00-59)</td>
<td>02</td>
</tr>
<tr>
<td>%m</td>
<td>Month as decimal number (00-12)</td>
<td>05</td>
</tr>
<tr>
<td>%m/%d/%y</td>
<td>Mm/dd/yy</td>
<td>10/18/01</td>
</tr>
<tr>
<td>%m/%d/%Y</td>
<td>Mm/dd/yyyy</td>
<td>10/18/2001</td>
</tr>
<tr>
<td>%p</td>
<td>Current locale’s AM/PM indicator for 12-hour clock</td>
<td>AM</td>
</tr>
<tr>
<td>%S</td>
<td>Second as decimal number (00-59)</td>
<td>45</td>
</tr>
</tbody>
</table>
End-User Guide

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>%U</td>
<td>Week of year as decimal number, with Sunday as first date of week (00-51)</td>
<td>19</td>
</tr>
<tr>
<td>%W</td>
<td>Week of year as decimal number, with Monday as first date of week (00-51)</td>
<td>20</td>
</tr>
<tr>
<td>%w</td>
<td>Weekday as decimal number (0-6; Sunday is 0)</td>
<td>5</td>
</tr>
<tr>
<td>%x</td>
<td>Date representation for current locale</td>
<td>10/18/01</td>
</tr>
<tr>
<td>%X</td>
<td>Time representation for current locale</td>
<td>10:15:45</td>
</tr>
<tr>
<td>%Y</td>
<td>Year with century, as decimal number</td>
<td>2001</td>
</tr>
<tr>
<td>%y</td>
<td>Year without century, as decimal number (00-99)</td>
<td>01</td>
</tr>
<tr>
<td>%z</td>
<td>Time-zone name or abbreviation; no characters if time zone is unknown</td>
<td>CENTRAL STANDARD TIME</td>
</tr>
<tr>
<td>&lt;user&gt;</td>
<td>User name</td>
<td>USER 2</td>
</tr>
</tbody>
</table>

Add a stamp annotation

In PowerView, the Stamp icon 🏷️ annotation enables you to stamp predefined (Approved, Confidential, Rejected, and so forth) or custom messages on document images.

The Stamp menu has several standard stamps that are ready for you to use. To create a customized stamp, you can use the Rubber Stamp Wizard.

1. In PowerView, open the document to which you want to add the annotation.
2. On the Annotation toolbar, click the Stamp icon 🏷️.
3. From the Stamp list, click the type of stamp you want. The cursor will display as a crosshair.
4. Click the document image where you want the stamp message to be placed.

![Image of a stamp on a document]
Remove a stamp
1. In PowerView, click the Stamp icon  and then click Edit Stamps.
2. In the Rubber Stamp Wizard dialog box, select Remove/Disable/Enable a stamp, and then click Next.
3. In the stamp list, select the stamp you want to permanently remove, and then click Remove.
   **Note** Stamps previously placed in document images will not be removed.

Turn a stamp on or off
1. In PowerView, click the Stamp icon  and then click Edit Stamps.
2. In the Rubber Stamp Wizard dialog box, select Remove/Disable/Enable a stamp, and then click Next.
3. Clear the checkbox of the stamp you want to disable, and then click Finish.
   **Note** The stamp is not deleted from the system, it is only disabled; a disabled stamp can be enabled. Stamps previously placed in a document image will not be removed.

Run the Rubber Stamp Wizard
The Rubber Stamp Wizard enables you to create, modify, remove, and configure customize Rubber Stamp annotations.
1. In PowerView, click the Stamp icon  and then click Edit Stamps.
2. In the Rubber Stamp Wizard dialog box, click Next.
3. The following options are available:
   - Adding a stamp
   - Modifying a stamp
   - Remove / Disable / Enable a stamp
4. Select the task you want to perform, and then click Next.

Customize annotations

Set annotation preferences
1. Open a document in PowerView.
2. In the PowerView window, on the Annotation menu, point to Preferences, click any of the following, choose your settings, and then click OK:
   - **Font** - Customizes the font of the Text  annotation.
   - **Pen Width** - Customizes the width of the line used in the Redline  and Arrow  annotations.
   - **Pen Color** - Customizes the color of the line used in the Redline  and Arrow  annotations.
   - **Highlight Color** - Customizes the color of the highlighter used in the Highlight  annotation.
   - **Solid Mask Color** - Customizes the color of the Solid Mask used in the Solid Mask  annotation.
   - **Hollow Mask Color** - Customizes the color of the Hollow Mask used in the Hollow Mask  annotations.
Modify a stamp

1. In PowerView, click the Stamp icon  and then click Edit Stamps.
2. In the Rubber Stamp Wizard dialog box, select Modify a stamp, and then click Next.
3. In the stamp list, select the stamp you want to modify, and then click Next.
4. In the Text Stamp Page 1 dialog box, in the Text Line fields, modify the stamp text.
5. Click the Font button to adjust the font and font size.
6. Click the <<Insert Code button to insert pre-defined date, time, and user codes, and then click Next.
7. In the Text Stamp Page 2 dialog box, click the Frame list to select a shape for the stamp.
8. Click the Border slider to configure the stamp border.
9. Click the Font Color, Fill Color, and Frame Color lists to select the stamp color.
10. Click Finish. The stamp will reflect the changes next time it is used.

Note Stamps previously placed in document images will not reflect new stamp changes.

Move or resize an annotation

On the PowerView Annotation toolbar, the Move/Resize icon  enables you to move, resize, and delete existing annotations on a document image.

Move an annotation

1. In PowerView, locate the document you want to view.
2. On the Annotation toolbar, click the Move/Resize icon . The cursor will change into a crosshair.
3. Click on the annotation you want to move. The annotation will be outlined with a dotted line with large black squares.
4. Click and hold the mouse button on the selected annotation; move the annotation were you want to put it. Release the mouse button.
5. Click outside of the annotation to deselect it.

Resize an annotation

1. In PowerView, locate the document you want to view.
2. On the Annotation toolbar, click the Move/Resize icon . The cursor will change into a crosshair.
3. Click on the annotation you want to resize. The annotation will be outlined with a dotted line with large black squares.
4. Click and hold the mouse button on one of the black squares; drag to resize the annotation to the size you want it. Release the mouse button.
5. Click outside of the annotation to deselect it.

Note The Stamp, Text, and Sticky Note annotations cannot be resized using the Move/Resize icon . However, Stamp default sizes can be modified using the Rubber Stamp Wizard; text default sizes can be changed using Annotation Preferences.
Index

<table>
<thead>
<tr>
<th>A</th>
<th>54, 57</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced search</td>
<td></td>
</tr>
<tr>
<td>Alarms</td>
<td>77</td>
</tr>
<tr>
<td>Annotations</td>
<td>91, 92, 93, 94, 95, 96, 97, 98, 99, 101, 102</td>
</tr>
<tr>
<td>Appearance</td>
<td>28, 31</td>
</tr>
<tr>
<td>Applet</td>
<td>3, 64</td>
</tr>
<tr>
<td>Arrow</td>
<td>97</td>
</tr>
<tr>
<td>Associated application</td>
<td>28</td>
</tr>
<tr>
<td>Attach</td>
<td>97</td>
</tr>
<tr>
<td>B</td>
<td>43, 47</td>
</tr>
<tr>
<td>Batch</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>32, 64</td>
</tr>
<tr>
<td>Columns</td>
<td></td>
</tr>
<tr>
<td>Content search</td>
<td>57, 66, 70</td>
</tr>
<tr>
<td>Content Server</td>
<td>56, 66, 70</td>
</tr>
<tr>
<td>Copy</td>
<td>46</td>
</tr>
<tr>
<td>Customize</td>
<td>20, 21, 32, 64</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>38, 82, 83, 96</td>
</tr>
<tr>
<td>Discard</td>
<td>45</td>
</tr>
<tr>
<td>Disconnect</td>
<td>5</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>E-mail</td>
<td>49, 50</td>
</tr>
<tr>
<td>EOB processing</td>
<td>85, 86</td>
</tr>
<tr>
<td>ERM search</td>
<td>57, 65, 70</td>
</tr>
<tr>
<td>Exit</td>
<td>6</td>
</tr>
<tr>
<td>Explore</td>
<td>57</td>
</tr>
<tr>
<td>Export</td>
<td>33, 50</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Full text search</td>
<td>70</td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>Grabber feature</td>
<td>29</td>
</tr>
<tr>
<td>Grayscale</td>
<td>31</td>
</tr>
<tr>
<td>Grid</td>
<td>32, 62, 63, 74</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>6, 7</td>
</tr>
<tr>
<td>Highlight</td>
<td>91</td>
</tr>
<tr>
<td>Hold</td>
<td>45, 81</td>
</tr>
<tr>
<td>Hollow mask</td>
<td>92</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>ImageNow Printer</td>
<td>36</td>
</tr>
<tr>
<td>Import</td>
<td>36</td>
</tr>
<tr>
<td>Indexing</td>
<td>43</td>
</tr>
<tr>
<td>invert</td>
<td>28</td>
</tr>
<tr>
<td>K</td>
<td></td>
</tr>
<tr>
<td>Keys</td>
<td>10</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Linking</td>
<td>43, 45, 46, 47, 82, 86</td>
</tr>
<tr>
<td>Lock</td>
<td>62</td>
</tr>
<tr>
<td>Log in</td>
<td>1</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>Move</td>
<td>21, 46, 102</td>
</tr>
<tr>
<td>Multiple</td>
<td>53</td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>27, 33</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>PowerView</td>
<td>20, 21, 23, 24</td>
</tr>
<tr>
<td>Preview</td>
<td>16, 35, 84</td>
</tr>
<tr>
<td>Print</td>
<td>35, 36</td>
</tr>
<tr>
<td>Properties</td>
<td>31, 33</td>
</tr>
<tr>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Quality assurance (QA)</td>
<td>40, 41, 42, 46</td>
</tr>
<tr>
<td>Query</td>
<td>56</td>
</tr>
<tr>
<td>Queue</td>
<td>76, 78, 79</td>
</tr>
<tr>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Refresh</td>
<td>32, 33</td>
</tr>
<tr>
<td>Remove from workflow</td>
<td>83</td>
</tr>
</tbody>
</table>